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1-1Introduction

Chapter 1. Introduction

About this Guide
The HACMP Cluster Management Knowledge Module for PATROL contains detailed
information about the application, commands and parameters provided by the Knowledge
Module. This Guide also contains instructions for installing, configuring and loading the
HACMP Cluster Management Knowledge Module for PATROL.

Use this Guide with the appropriate PATROL user guide for your console, which describes
how to use PATROL to perform typical tasks.

This chapter discusses the following.

• About this guide 1-1

• Who should read this manual ? 1-1

• How this manual is organized ? 1-1

• Related publications 1-3

• Where to look for information 1-4

Who should read this manual ?
This manual is intended for cluster administrators and anyone who monitors HACMP
configuration.

This manual assumes that you are familiar with the HACMP product and your host
operating system. You should also know how to perform a basic set of actions in a window
environment, including:

• choosing menu commands

• moving and resizing windows

• opening icon windows

• dragging and dropping icons

• using mouse controls for your system
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How this manual is organized ?
This guide is organized as follows:

Chapter Title Purpose

1 ”Introduction” Provides an overview of the features and components
of the KM.

2 ”Getting Started” Provides information on setting up and accessing the
KM and provides basic information about the KM.

3 ”Menu Summary” Discusses the menus that the KM offers.

4 ”Parameters” Discusses the parameters that the KM offers.

5 “HACMP Cluster
Management Specificities”

Describes how HACMP Cluster Management KM
works.

6 “Using the HACMP Cluster
Management KM for
PATROL”

Describes tasks that you can perform with the HACMP
Cluster Management Knowledge Module for PATROL.

7 “Event Messages” Event messages

”Index”
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Related publications
PATROL product documentation consists of both hardcopy and online publications. PATROL
hardcopy documentation is divided into the following categories based on function:

Category Document Purpose

PATROL Base
Documents

PATROL for Unix
Getting Started

Provides procedures and examples to introduce
PATROL Console for Unix.

PATROL Agent
Reference Manual

Describes the PATROL Agent and explains how it
interacts with other PATROL components. It also
describes configuration utilities and Management
Information Base (MIB) tables used with the Agent.

PATROL for Unix
User Guide

Contains task-oriented information on how to
complete appropriate dialog boxes to manage the
computers, applications and parameters that PATROL
is able to manage using the PATROL console for Unix.

PATROL for Windows
NT
User Guide (volumes
1,2,3)

Contains task-oriented information on how to
complete appropriate dialog boxes to manage the
computers, applications and parameters that PATROL
is able to manage using the PATROL console for
Windows NT.

PATROL Command
Line Interfaces
Reference Manual

Describes the PATROL command line interfaces for
the PATROL Agent and the PATROL console.

PATROL
Installation
Documents

PATROL Installation
Guides

Describes how to run the installation program to load
the platform-specific PATROL Agents, PATROL
Consoles, and PATROL KMs.

PATROL
Integration
Documents

PATROLVIEW
User Guides

Describes the PATROLVIEW products.
PATROLVIEW allows you to fully integrate PATROL
with leading enterprise management products.

PATROLINK for
CA-Unicenter
Reference Manual

Provides information about installing and configuring
the PATROLINK product for your particular site.
PATROLINK allows you to connect to PATROL from
the CA-Unicenter console.

PATROL
Event Manager

PATROL Event
Manager Console for
Unix User Guide

Describes the stand-alone Event Manager Console for
Unix provided with the PATROL product. The PEM
Console is a graphical user interface that allows you
to manage the events generated by PATROL and
Knowledge Modules.

PATROL Event
Manager Console for
Windows
User Guide

Describes the stand-alone event Manager for
Windows NT.

PATROLWATCH PATROLWATCH for
Web Browsers
User Guide

Provides the ability to view PATROL monitored hosts
and applications using the Internet and
platform-specific browsing technology.

PATROL
Knowledge
Modules (KM)
Documents

Specific PATROL
Knowledge Module
user guides

Contains task-oriented information for loading and
modifying individual PATROL KMs used in monitoring
and managing your specific applications.
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PATROL
Software
Developer Kit
(SDK)

PATROL Script
Language Reference
Manual

describes the PATROL Script Language (PSL) data
types, syntax, operators, statements and built-in
functions.

PATROL Script
Language Debugger for
Unix Reference Manual

Discusses the PSL debugger available through the
PATROL developer console for Unix. The PSL
debugger provides an interactive GUI environment for
debugging PSL processes and scripts.

PATROL Online Help
Developer’s Guide

Provides guidelines and procedures for implementing
a BMC Software Help File. This guide includes
elements of style, design and presentation.

PATROL Knowledge
Module Developer’s
Guide

Presents the objectives, methods and requirements of
PATROL Knowledge Module development and
includes elements of KM style, setup application,
packaging, structure, efficiency and usage.

PATROL API
Reference Manual

Describes how you can incorporate your KM
customizations into the current version.

Utility Document PATROL KM Migrator
User Guide

Describes how you can incorporate your KM
customizations into the current version.

Supplement
Documents

Release Notes and
Technical Bulletins

Explains the latest updates to PATROL products.

These hardcopy publications can be requested from BMC Software, Inc., or can be viewed
on BMC Software’s Internet World Wide Web site (http://www.bmc.com/) when you have
registered for Customer Support. Each PATROL Console and each Knowledge Module
come with an extensive online help facility that is available through the PATROL Console
Help menu option. The online documentation contains reference information about PATROL
features and options and about KM parameters.

Where to look for information
The following table summarizes where to look for more information on using PATROL,
Knowledge Modules and PATROL integration products to perform typical tasks.

If you want information about... See the...

Adding computers to PATROL PATROL for Unix Getting Started
or PATROL for Windows NT User Guide (vol 1)

Changing the behavior of the PATROL Console or
the PATROL Agent by using a script or operating
system command line

PATROL Command Line Interface Reference Manual

Changing the PATROL Agent configuration PATROL Agent Reference Manual

Charting various parameters in a real-time
environment

PATROL Console Charting Server Reference Manual
or PATROL for Windows NT User Guide (vol 2)

Connecting to PATROL from a network manager PATROLVIEW User Guide
and PATROLINK for CA-Unicenter Reference Manual

Defining your monitoring environment PATROL for Unix Getting Started
or PATROL for Windows NT User Guide (vol 1)

Generalities on KMs PATROL for Unix Getting Started
or PATROL for Windows NT User Guide (vol 1)

KM versioning and customizations PATROL for Unix Getting Started
or PATROL for Windows NT User Guide (vol 3)
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Managing monitored objects PATROL for Unix Getting Started
or PATROL for Windows NT User Guide (vol 3)

Specific applications appropriate Knowledge Module’s User Guide
and Online Help

Specific menu commands appropriate Knowledge Module’s User Guide
and Online Help

Specific parameters appropriate Knowledge Module’s User Guide
and Online Help

Starting and stopping the PATROL Console PATROL installation guides,
PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 1)

Starting and stopping the PATROL Agent PATROL installation guides,
PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 1)

Managing Events PATROL Event Manager for Unix User Guide,
PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 2)

The PATROL interface PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 1)

The PATROL Script Language (PSL) PATROL Script Language Reference Manual

Working with menu commands PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 2)

Working with parameters PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 2)

Working with tasks PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 2)

Unloading a KM appropriate Knowledge Module’s User Guide,
PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 1)

Customizing commands
(PATROL Developer Console required)

PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 3)

Customizing a computer class
(PATROL Developer Console required)

PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 3)

Customizing an Info Box
(PATROL Developer Console required)

PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 3)

Defining an application
(PATROL Developer Console required)

PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 3)

Defining a parameter
(PATROL Developer Console required)

PATROL for Unix Getting Started
and PATROL for Windows NT User Guide (vol 3)

PSL commands and writing PSL scripts
(PATROL Developer Console required)

PATROL Script Language Refrence Manual

Debugging your PSL scripts
(PATROL Developer Console required)

PATROL Script Language Debugger for Unix
Reference Manual
or PATROL for Windows NT User Guide (Vol 2)
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Where to Go from Here
The following table suggests topics that you should read next:

if you want information on... See...

How to load the PATROL KM Chapter 2, “Getting  Started.”

What a certain menu command does Chapter 3, “Menu Summary” and the help.

What a certain parameter does Chapter 4, “Parameter Summary” and the help.

How HACMP Configuration element are 
represented

Chapter 5, “HACMP Cluster Management
Specificities” and the help.

The tasks you can perform with the HACMP Cluster
Management Knowledge Module for PATROL

Chapter 6, “Using the HACMP Cluster Management
KM for PATROL” and the help.

Event messages Chapter 7, “Event Messages” and the help.



2-1Getting Started

Chapter 2. Getting Started

This chapter provides information that you will need to get started with the PATROL
Knowledge Module� for Bull Cluster.

This chapter discusses the following:

• HACMP Cluster Management KM for PATROL 2-2

• Applications and Icons 2-3

• InfoBoxes 2-7

• Installing HACMP Cluster Management KM for PATROL 2-11

• Preparing to use the HACMP Cluster Management KM for Patrol 2-15

• Customizing HACMP Cluster Management KM for Patrol 2-16

• Loading HACMP Cluster Management KM for Patrol 2-19

• Verifying Configuration 2-19

• Help 2-20

• Softcopy Documentation 2-20

• Resetting Event Alarms 2-22

• Deinstalling HACMP Cluster Management KM for Patrol 2-22
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HACMP Cluster Management KM for PATROL
The HACMP Cluster Management KM for PATROL contains the knowledge that PATROL
uses during HACMP monitoring, analysis and management activities.

A Knowledge Module is a file containing knowledge in the form of command descriptions,
application, parameters and recovery actions that PATROL can use to monitor HACMP
events.

The HACMP Cluster Management KM for PATROL application classes instances show you
an exact representation of your HACMP configuration.

The HACMP Cluster Management KM for PATROL parameters allow you to survey HACMP
critical resources easily because they can provide a detailed report of all resources used by
HACMP. Moreover, you will have a global view of your cluster, bringing to you more
pertinent information on your systems.

By enabling you to detect problems, optimize systems, analyze trends, plan capacity and
manage multiple hosts simultaneously, the HACMP Cluster Management KM for PATROL
helps you ensure that your HACMP applications run efficiently 24 hours a day.
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Applications and Icons
Table 1 contains information on each application in the HACMP Cluster Management KM for
PATROL

You can force an update of the parameters in the BCL_COLLECT application class. All
other applications contain only consumer parameters which you cannot directly update.

Table 1. HACMP Cluster Management KM for PATROL Applications, Icons and Descriptions

Icon Definition

BCL_ADAPTER application instance:
Represents an adapter in HACMP configuration.

BCL_APPLICATIONSERVER application instance:
Represents an application server in HACMP configuration.

BCL_CLUSTER application instance:
Represents a cluster in HACMP configuration.
These instances appear directly in the PATROL console main window, like other
computer instances.

BCL_COLLECT application instance:
Maintains all of the collector parameters, and allows you to refresh them.
A unique instance is available for this class on a cluster node.

BCL_EVENT application instance:
Represents an HACMP predefined event.
An class Icon regroups all instances of this type.

BCL_FILESYSTEM application instance:
Represents a filesystem used in HACMP configuration.

BCL_HACMP application instance:
Represents the main entrance point for all local resources configured on a cluster
node.
A unique instance is available in the system window.

BCL_NETWORK application instance:
Represents a network configured in HACMP.
Regroups all adapter instances.

BCL_NODE application instance:
Represents a node configured in HACMP.
Shows the state of HACMP daemons on the target system, PATROL agent
presence and local resources state.

BCL_PHYSICALVOLUME application instance:
Represents a physical volume used in HACMP configuration.
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BCL_RESOURCEGROUP application instance:
Represents a group of resources defined in HACMP configuration.
Indicates the state and location of this item into the cluster.

BCL_RESOURCES application instance:
Represents a set of local resources used by a group of resources in HACMP 
configuration.
Regroups application servers and volume groups instances.

BCL_VOLUMEGROUP application instance:
Represents an AIX volume group used in HACMP configuration.
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Application Hierarchy
The HACMP Cluster Management KM for PATROL is arranged in a hierachical structure.
Moreover, its applications are separated in two different trees, according to their nature:

The first tree of applications represents icons under a system window, e.g. they are
available on the system window of each cluster node. These are applications corresponding
to local elements encountered on a system:

BCL_HACMP instance represents the state of HACMP application on a given cluster node

BCL_COLLECT instance represents the state of all collector parameters on a given
cluster node

BCL_EVENT instances represent the state of HACMP events on a given cluster node

BCL_RESOURCES instances represent the state of all resources defined in a resource
group on a given cluster node. These are composed of:

BCL_APPLICATIONSERVER instances represent the application servers on a given
cluster node

BCL_VOLUMEGROUP instances represent the state of volume groups, defined into
HACMP configuration, on a given cluster node. These are composed of:

BCL_FILESYSTEM instances represent the state of filesystems, used in HACMP
configuration, on a given cluster node

BCL_PHYSICALVOLUME instances represent the state of physical volumes, used
in HACMP configuration, on a given cluster node
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The second tree of applications represents icons under the main PATROL console window
and represents global information about a cluster state. These are applications
corresponding to global elements encountered on a cluster:

BCL_CLUSTER instance represents the general state of the cluster defined in HACMP
configuration

BCL_NODE instances represent the state of the cluster nodes defined in HACMP
configuration

BCL_RESOURCEGROUP instances represent the state of resource groups defined in
HACMP configuration.

BCL_NETWORKS instances represent the state of networks defined in HACMP
configuration. These are composed of:

BCL_ADAPTER instances represent the adapters defined in HACMP configuration
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InfoBoxes
InfoBoxes display summary information about an instance or application.

BCL_ADAPTER Application InfoBox

InfoBox Item                                    Definition

Adapter Type The type of adapter defined in HACMP configuration (IP, atm,
ether, fddi, hps, rs232, tmscsi, tmssa, token)

IP Address Dotted IP address defined in HACMP configuration for this
adapter

Hardware Address When defined in cluster configuration, indicates the hardware
address to configure with this adapter on any IP interface used

Interface If used, the IP interface name using this HACMP object
NB: This information can change in the case of a takeover

Node If used, the actual node using the IP address indicated for this
adapter
NB: This information can change in the case of a takeover

Function The function defined for this object in HACMP configuration 
(service, boot, standby)

BCL_APPLICATIONSERVER Application InfoBox

InfoBox Item                                    Definition

Start Script The script used to start the application described in the resource
group HACMP concept

Stop Script The script used to stop the application described in the resource
group HACMP concept

Rolling Address When used in rolling application style, indicates the dotted IP 
address used to configure on appropriate node when a move of 
corresponding resource group is required by HACMP or by user.

Rolling Address Name The label for the rolling address described above

BCL_CLUSTER Application InfoBox

InfoBox Item                                    Definition

Cluster Name The name of the cluster defined in HACMP configuration

Cluster ID The identifier defined for the cluster in HACMP configuration

Nodes The participating node list, according to HACMP configuration

Primary Node The node name elected by all available nodes of the cluster to 
represent its state

Cluster Security The security defined for the cluster in HACMP configuration

Number of Nodes The number of nodes for the cluster

IP Aliasing Flag for IP aliasing usage: 1 if IP aliasing is used, 0 else

Specific Configuration The indication of specific configuration for the cluster (Standard,
CRM, Native HA, Disaster Recovery, Rolling)
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BCL_COLLECT Application InfoBox

InfoBox Item                                    Definition

KM Log Maximum Size The maximum size for the HACMP Cluster Management 
Knowledge Module in Kilobytes

BCL_EVENT Application InfoBox

InfoBox Item                                    Definition

Event State The last state for the event (STARTED, COMPLETED,
STARTED).
If this event are not occured, this field is empty

Date of last occurence The date and time of last occurence for this event

Arguments The arguments used by this event during its last occurence

BCL_FILESYSTEM Application InfoBox

InfoBox Item                                    Definition

Logical Volume The logical volume used by this file system

Mounting Point The mounting point used for accessing the file system

Size The occupied size of the file system (in Kilobytes)

Options The optional arguments used for the file system

Filesystem Type The type of this file system (jfs, nfs,...)

Remote Node Name for
NFS

If NFS type, the server name that exports this mounted NFS file
system. 
N/A for other type of file systems.

BCL_HACMP Application InfoBox

InfoBox Item                                    Definition

Clstrmgr The state of clstrmgr daemon (started, stopped)

Clinfod The state of clinfod daemon (started, stopped)

Clsmuxpd The state of clsmuxpd daemon (started, stopped)

Cllockd The state of cllockd daemon (started, stopped)

AIX Level The level of AIX operating system (based on bos.mp fileset)

HACMP Level The level of HACMP package (based on cluster.es.server.utils 
fileset)

Bullcluster Level The level of Bullcluster package (based on bullcluster.admin.mo-
nitoring fileset)

KM Version The version of HACMP Cluster Management KM for PATROL

Debug Mode The actual debugging mode (normal, verbose)

Maintenance Mode The actual maintenance mode (enabled, disabled)
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BCL_NETWORK Application InfoBox

InfoBox Item                                    Definition

Network Type The type of network defined in the HACMP configuration (IP,
atm, ether, fddi, hps, rs232, tmscsi, tmssa, token)

BCL_NODE Application InfoBox

InfoBox Item                                    Definition

HACMP State The state of HACMP services on the node (started, stopped)

Patrol Agent State The state of PATROL Agent on the node (started, stopped)

Local Resources State The state of local resources defined in HACMP configuration
and owned by the node (worst state among events state, 
resources state, file systems state, volume groups state and
physical volumes state)

BCL_PHYSICALVOLUME Application InfoBox

InfoBox Item                                    Definition

pvid The physical volume identifier given for this disk

Volume Group The volume group that owns the physical volume

Physical Location The operating system physical location of the physical volume

Description The description provided to name the physical volume

Manufacturer The manufacturer of that type of physical volume

Scsi Parent The scsi parent that drives the physical volume

BCL_RESOURCEGROUP Application InfoBox

InfoBox Item                                    Definition

Actual Node The node(s) name(s) that actually owns the resource group. For
concurrent resource groups, this field contains all nodes names
that actually run the resource group

Participating Nodes The priority list of nodes involved in takeover relationship for the
resource group

Relationship The takeover relationship among the cluster nodes for the 
resource group (cascading, concurrent, rotating)

Sticky Location The node name that owns the sticky location set by a ”sticky
move” of this resource group. Sticky location has priority on ”par-
ticipating nodes list” for takeover relationship

Current State The actual state of this resource group (UP, DOWN, ???)
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BCL_RESOURCES Application InfoBox

InfoBox Item                                    Definition

Service Label The service address attached to the resource group. 
Not available for shared resource groups (CRM configurations)

Original Node The node name on which the resource group is started initially

Filesystems 
Consistency Check

The check method for filesystems consistency

Filesystems Recovery
Method

The recovery method for filesystems consistency

AIX Connections
Services

See specific information in HACMP guides if you use AIX 
connections services

AIX Fast Connect
Services

See specific information in HACMP guides if you use AIX fast 
connect services

HACMP Communication
Links

See specific information in HACMP guides if you use CS/AIX 
communications links

Miscellaneous Data A text string to put additionnal information in resource group 
environment

Inactive Takeover
Activated

Flag for cascading resource group (false [default], true).If ’true’,
it allows the first node in the resource group participating node
list to join the cluster (i.d. to start HACMP services) to acquire
the resource group

9333 Disk Fencing 
Activated

Specific flag for managing IBM 9333 disk subsystem. See
HACMP guides for more information

SSA Disk Fencing 
Activated

Specific flag for managing SSA disk subsystem. See HACMP
guides for more information

FS mounted before IP The order of configuration between filesystem mount and IP
adresses setup

BCL_VOLUMEGROUP Application InfoBox

InfoBox Item                                    Definition

Mode The volume group mode declared in HACMP configuration 
(concurrent, not concurrent)

Actual State The actual activation state for the volume group (varied on, 
varied off)
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Installing HACMP Cluster Management KM for PATROL
This section describes the procedures for setting up your system to work with HACMP
Cluster Management KM for PATROL. This Knowledge Module is to be installed on each
cluster node to survey and on the Patrol console which will manage the clusters.

PATROL VersionRequirements
HACMP Cluster Management KM for PATROL requires PATROL version 3.3 or above.

PATROL agent or PATROL console must be already installed and configured in order to
install HACMP Cluster Management KM and $PATROL_HOME variable must be set
correctly on UNIX systems.

System Requirements
Your system operating level must be AIX version 4.3.3 or higher on all your cluster nodes.
You can verify this by using the command:  #  lslpp –cL bos.mp

You must have already installed HACMP version 4.3.1 or above. You can verify this by using
the command:  #  lslpp –cL cluster.es.server.utils

Even if you may use HACMP Cluster Management KM for PATROL without using
HACMP Cluster Management software, it is recommended to install it for using various
useful tools and commands on your cluster.

If you have installed it on your cluster, it must be version 4.3.1 or higher. You can verify
this by using the command: # lslpp –cL bullcluster.

Compatibility with Previous HACMP Cluster Management KM for
PATROL

The present KM is not compatible with the one delivered on Cluster Assistant CD–ROM
(bullcluster.patrol.km 4.3.2.0). However, the present KM is usable directly on cluster nodes
instead of the Power Console. If you do not use the Power Console as a Patrol Console,
you need not to follow the procedure below for installing the current software.

If you want to install the current software on a Power Console, which will be used as a
Patrol Console, and have done several customizations on the previous HACMP Cluster
Management KM for PATROL, it is recommended to save this KM by recording the modified
files to retrieve information later.

You can verify if the previous KM is installed on your system by using the command:

# lslpp –cL bullcluster.patrol.km

If you have already installed the HACMP Cluster Management KM for PATROL package
”bullcluster.patrol.km 4.3.2.0” and you want to replace it by the new one, you must
previously desinstall this old software before installing this version:

Type: smit remove

Press (F4–Esc4) to get a list of package to desinstall.

Select: SOFTWARE name: [bullcluster.patrol.km]

Follow the instructions given on the screen

When the procedure is completed exit smit (F10–Esc0)
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Disk and Memory usage
During installation of HACMP Cluster Management KM for PATROL, you must have at least
8 Mbytes of free space in the filesystem containing PATROL.

This amount of free space includes HACMP Cluster Management KM for Patrol log file with
its default maximum size (100 Kb).

The filesystems /usr and the one containing PATROL may not be used at 100% of their
capacities (you can verify by using the df command).

Preparing to install the HACMP Cluster Management KM for PATROL
Before installing the HACMP Cluster Management KM for PATROL, you must perform
certain tasks before you can use the KM on UNIX (including AIX) system.

Log in PATROL user.

– Reserve enough space in PATROL user directory to install the KM (8 Mbytes).

– Expand /usr and PATROL user filesystem if 100% full (df command)

– Verify your PATROL environment, especially the PATROL_HOME variable. If not set,
configure it by editing the .profile file and adding at end of file the lines:

– ”cd ./PATROL3.3”  ### For PATROL Version 3.3

– ”. ./patrolrc.sh”

Then log out and log in PATROL user back : $PATROL_HOME is set correctly.

Previously to configure the KM itself, it is recommended to use IP aliasing facility (if
available) to get an address always available (HACMP running or not): the boot address. To
activate this feature: use ”smit bcl_alias” command and change flag to ”yes”.

IP aliasing is a Bull feature for HACMP. You must have bullcluster.basic_soft.ha_cmp
package installed to use it.

If you have not or if you do not want to configure it, you can use an administration address
on each node, that cannot be modified by HACMP.

If you have no administration address, HACMP Cluster Management KM cannot fulfill its
work correctly by retrieving continuously information about the cluster.

Installing HACMP Cluster Management KM for an AIX PATROL console
This section indicates the steps for installing this knowledge module on an AIX PATROL
console.

Insert the ”HACMP Cluster Management KM for PATROL” CD–ROM into your CD–ROM
drive.

Use smit interface to correctly install the HACMP Cluster Management KM for PATROL
package.

– Log in root user.

Type: smit install_selectable_all

Select: INPUT device/directory for software: [/dev/cd0]

Press F4 or Esc–4 to get a list of filsets to install

Select “bullcluster.kmpatrol” package

When the procedure is complete, exit smit (F10–Esc0)

Type: cd /usr/lpp/bullcluster.kmpatrol

Type: ./install_km
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Follow instructions of this script: enter PATROL user and PATROL_HOME directory. Choose
a PATROL Console installation.

– Installation is complete.

Installing HACMP Cluster Management KM for a NT console
This section indicates the steps for installing this knowledge module on a NT PATROL
console.

Insert the ”HACMP Cluster Management KM for PATROL” CD–ROM into your CD–ROM
drive.

Double click on the CD–ROM icon in your Windows NT desktop

Change directory to: NT

Execute the BCL_NT_console.exe file

Follow the instructions: enter your PATROL_HOME directory (default is C:\PATROL3.3), and
press the Unzip button.

Installation is complete: press the Close button to close the window.

Installing HACMP Cluster Management KM for an unix PATROL console
This section indicates the steps for installing this knowledge module on an UNIX PATROL
console, if your UNIX operating system is not AIX.

Reserve 2 additionnal Mbytes for copying the tar file containing PATROL console
information for the KM into PATROL user directory.

Insert the ”HACMP Cluster Management KM for PATROL” CD–ROM into your CD–ROM
drive.

– Log in the PATROL user.

– Verify $PATROL_HOME variable is set correctly. If not set, add

Use the mount command with appropriate options depending on your OS to mount your
CD–ROM device on a temporary mount point.

Change current directory to the CD–ROM mount point (cd command).

Change current directory to NT directory on CD–ROM (cd command).

Copy the BCL_UNIX_console.tar file into $PATROL_HOME

Type: tar –xovf BCL_UNIX_console.tar

Remove temporary file: rm BCL_UNIX_console.tar

Installation is complete: you can now unmount you CD–ROM drive.

Installing HACMP Cluster Management KM for an AIX PATROL agent
This section indicates the steps for installing this knowledge module on an AIX PATROL
agent, in order to monitor a cluster node (AIX – RS6000 platform).

Insert the ”HACMP Cluster Management KM for PATROL” CD–ROM into your CD–ROM
drive.

Use smit interface to correctly install the HACMP Cluster Management KM for PATROL
package.

– Log in root user.

Type: smit install_selectable_all

Select: INPUT device/directory for software: [/dev/cd0]
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Press F4 or Esc–4 to get a list of filsets to install

Enter “ALL” for SOFTWARE to install field

When the procedure is complete, exit smit (F10–Esc0)

Type: cd /usr/lpp/bullcluster.kmpatrol

Type: ./install_km

Follow instructions of this script: enter PATROL user and PATROL_HOME directory. Choose
a PATROL Agent installation.

Note: You will have to enter root password several times in order to set acces rights
correctly to all binaries used by the KM.

– Installation is complete.



2-15Getting Started

Preparing to use the HACMP Cluster Management KM for
PATROL

Operations described below are only to be done on cluster nodes, for PATROL agent
configuration.

There is different information to provide to the HACMP Cluster Management KM for
PATROL to make it work correctly:

• Identifies PATROL user names on each node of the cluster: if they are different from
PATROL user name on the local node, indicate it by updating KM configuration file: insert
a new line:

     ”Patrol_User_node=patrol_user”

for each remote node node for wich PATROL user patrol_user is different from on local
node.

• Identifies administration addresses (addresses available with or without HACMP
running): if you do not use IP aliasing, configure it in KM configuration file: insert a new
line:

     ”Admin_Addr_node=admin_address”

for each remote node node for which administration address is admin_address.

• Configure .rhosts file in PATROL user directory to allow PATROL users from remote
cluster nodes to connect and share information with the local node. This can be done by
adding a new line:

     ”addr_node patrol_user”

in .rhosts file for each address addr_node potentially used by remote node to access
local node by PATROL user patrol_user.

This can also be done by using the Remote Users Configuration menu command from
BCL_HACMP application, when KM will be loaded.

Note:

• If you want to monitor properly your cluster, it is recommended to use your administration
addresses (the boot addresses defined in the HACMP configuration if you have activated
the IP aliasing facility) as host connections to your cluster nodes: since PATROL agent
can be accessed with or without HACMP running, connection addresses should be
reachableat any time.

•  It could be interessant to configure PATROL agent in order to start it automatically at
each cluster node reboot. You can do this by adding a new line in each cluster node
/etc/inittab file like:

”PatrolAgent:2:once:<your PATROL home directory>/../PatrolAgent &”
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Customizing HACMP Cluster Management KM for PATROL
All durable configuration settings are saved in the KM configuration file: BCL_conf.

Location:

This file is in $PATROL_HOME/BCL_KM/config directory

Function:

This file registers all configuration modifications using a set of variables. It may be modified
manually by a PATROL user, or you can use the menu command from the Developer
console to modify it.

If you change manually a variable in the configuration file, use the Refresh => ALL menu
command from BCL_HACMP application, to take changes into account.

Syntax:

Lines of this file must of the form:

<variable name>=<value>

All variable not set in this configuration file is set to ”___default___” (default value) for KM.

Example:

#### Example of file for a cluster node

# KM binaries files are in $PATROL_HOME/BCL_KM/bin/ directory

BCLBINPATH=$PATROL_HOME/BCL_KM/bin/

# Maximum log size for KM is 500 Kb

BCL_KM_Max_Log_Size=500

# Current node is in maintenance mode

BCL_KM_Maintenance_Mode=1

# Primary node for the cluster is node_name

BCL_Primary_Node=node_name

Table 2. Configuration Variables

Variable Name
 
 Description

 
Default Value

BCL_KM_Max_Log_Size Size in Kilobytes for HACMP

Cluster Management KM log

100

BCL_KM_Debugging_Mode Flag for debugging mode 0 (no debug)

BCL_Maintenance_Mode_node Flag for maintenance mode on

node node

0 (no maintenance)

BCLBINPATH Path for binaries directory (used

by the KM)

$PATROL_HOME/

BCL_KM/bin/

BCLREMOTEPATH Path for shared files directory $PATROL_HOME/re-

mote/

BCL_shared_info/

BCLLOGPATH Path for HACMP Cluster Man-

agement KM log file directory

$PATROL_HOME/log/

BCL_ADAPTER_Max_Instances Maximum number of

BCL_ADAPTER application

instances to monitor

0 (all instances

monitored)
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Variable Name
 
Default Value

 
 Description

BCL_ADAPTER_Pattern Pattern (1) of BCL_ADAPTER

application instances not to

monitor

”___default___” (all

instances monitored)

BCL_APPLICATIONSERV-

ER_Max_Instances

Maximum number of BCL_AP-

PLICATIONSERV ER applica-

tion instances to monitor

0 (all instances 

monitored)

BCL_APPLICATIONSERV-

ER_Pattern

Pattern (1) of BCL_APPLICA-

TIONSERV ER application

instances not to monitor

”___default___” (all

instances monitored)

BCL_EVENT_Max_Instances Maximum number of

BCL_EVENT application

instances to monitor

0 (all instances 

monitored)

BCL_EVENT_Pattern Pattern (1) of BCL_EVENT ap-

plication instances not to monitor

”___default___” (all

instances monitored)

BCL_FILESYS-

TEM_Max_Instances

Maximum number of BCL_FILE-

SYSTEM application instances

to monitor

0 (all instances 

monitored)

BCL_FILESYSTEM_Pattern Pattern (1) of BCL_FILESYS-

TEM application instances not to

monitor

”___default___” (all

instances monitored)

BCL_NET-

WORK_Max_Instances

Maximum number of BCL_NET-

WORK application instances to

monitor

0 (all instances 

monitored)

BCL_NETWORK_Pattern Pattern (1) of BCL_NETWORK

application instances not to

monitor

”___default___” (all

instances monitored)

BCL_NODE_Max_Instances Maximum number of

BCL_NODE application

instances to monitor

0 (all instances 

monitored)

BCL_NODE_Pattern Pattern (1) of BCL_NODE ap-

plication instances not to monitor

”___default___” (all

instances monitored)

BCL_PHYSICALVOLUME

_Max_Instances

Maximum number of

BCL_PHYSICALVOLUME ap-

plication instances to monitor

0 (all instances 

monitored)

BCL_PHYSICALVOLUME

_Pattern

Pattern (1) of BCL_PHYSICAL-

VOLUME application instances

not to monitor

”___default___” (all

instances monitored)

BCL_RESOURCEGROUP

_Max_Instances

Maximum number of BCL_RE-

SOURCEGROUP application

instances to monitor

0 (all instances 

monitored)

BCL_RESOURCEGROUP

_Pattern

Pattern (1) of BCL_RESOURCE-

GROUP application instances

not to monitor

”___default___” (all

instances monitored)

BCL_RESOURCES_Max

_Instances

Maximum number of BCL_RE-

SOURCES application instances

to monitor

0 (all instances

monitored)

BCL_RESOURCES_Pattern Pattern (1) of BCL_RE-

SOURCES application instances

not to monitor

”___default___” (all

instances monitored)
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Variable Name
 
Default Value

 
 Description

BCL_VOLUME-

GROUP_Max_Instances

Maximum number of BCL_VO-

LUMEGROUP application

instances to monitor

0 (all instances 

monitored)

BCL_VOLUMEGROUP_Pattern Pattern (1) of BCL_VOLUME-

GROUP application instances

not to monitor

”___default___” (all

instances monitored)

Patrol_User_node PATROL user name on node

node

same as on local node

Admin_Addr_node Administration address (always

available with or without HACMP

running) to access remote node

node

boot address

BCL_Primary_Node Primary node name ”___default___” (prima-

ry node is elected by all

available nodes)
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Loading HACMP Cluster Management KM for Patrol
Step 1 Choose File => Load KM from the PATROL Console menu bar.

A list of available Knowledge Modules for your site appears.

Step 2 Click on the BCL_ALL.kml file from the list.

Step 3 Click on OK.

When the KM is loaded, PATROL enters into a discovery phase.

Verifying Configuration
Make sure your remote node addresses are correctly configured on each node of your
cluster:

• Open your system window by doucle clicking the system icon in the main PATROL
console window.

• Use Remote Users Configuration menu command from BCL_HACMP icon. A window
appears indicating to you all addresses not configured.

• Press Configure button.

If you use addresses not defined in your HACMP configuration, add lines to the .rhosts file
for user PATROL on each node to allow PATROL user from remote node to use it. Lines will
match the syntax:

<node_address_on_remote_node> <PATROL_user_on_remote_node>

This configuration will allow the use of any available address to reach remote node.
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Help
Help describes the function of the currently displayed window or dialog box and the use of
its elements. You can display a list of help topics and search for a specific topic. The tasks
in this section describe how to access help topics and context–sensitive help from a
PATROL Console for Unix and a PATROL Console for Windows NT.

You can access PATROL KM help topics, context–sensitive application help and
context–sensitive parameter help.

Accessing Help from the PATROL Console for Unix
This task describes how to access PATROL KM Help topics. From the list of Help topics,
you can browse through a number of Help topics or search for a specific topic. You can also
access PARTOL KM context–sensitive Help for applications and parameters.

To access KM Help Topics

Step 1

Choose Help => On Knowledge Modules from the PATROL Console menu bar.

A dialog box appears listing the loaded PATROL KM Help files.

Step 2

Select HACMP Cluster Management KM for PATROL and click Go To.

The KM Help Topics screen is displayed.

To Access Context–Sensitive Application Help

 Perform one of the following actions:

• Select an application from Choose Help => This Application from the List of Applications
Classes window.

• Click the Show Help button on the Application Definition dialog box.

To Access Context–Sensitive Parameter Help

Perform one of the following actions:

• Choose Help On from a parameter pop–up menu.

• Choose Help from a parameter window.

• Click the Show Help button on the Parameter Definition dialog box.

Accessing Help from the PATROL Console for Windows NT
This task describes how to access PATROL KM Help topics. From the list of Help topics,
you can browse through a number of Help topics or search for a specific topic. You can also
access PARTOL KM context–sensitive Help for applications and parameters.

To Manually Open Help

Double Click \lib\help\WinHelp\BCL_help.hlp from the PATROL home directory.

The HACMP Cluster Management KM for PATROL Help system appears.

To Access Context–Sensitive Application Help

Perform one of the following actions:

• Choose Help On from an application pop–up menu.

• >From the Application Definition dialog box, click the Help tab; then click the Show Help
button.
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To Access Context–Sensitive Parameter Help

Perform one of the following actions:

•  Choose Help On from a parameter pop–up menu.

• Choose Help from a parameter window.

• >From the Parameter dialog box, click the Help tab; then click the Show Help button.

Softcopy Documentation
The documentation you are actually reading is available on the HACMP Cluster
Management KM for PATROL CD–ROM as a PDF file named ”BCL_User_Guide.pdf”, under
base directory for the CD_ROM (example for Windows NT: D:\BCL_User_Guide.pdf).
To reach it, insert this CD–ROM into your drive.
For Unix (including AIX) systems, mount the CD–ROM using the appropriate ”mount”
command.

This documentation needs Acrobat Reader software to be viewed. The tasks below indicate
how to install Acrobat Reader software according to your operating system:

Installing Acrobat Reader for AIX 
• Log on root user.

• Insert your HACMP Cluster Management KM for PATROL CD–ROM into your drive.

• Mount a temporary CD–ROM filesystem: mount –rv cdrfs /dev/cd0 /mnt.

• Type: cd /mnt/Acrobat/AIX.

• Launch smit interface: smit install_selectable_all.

• Select ”.” as INPUT device/directory for software.

• Select ”ALL” as SOFTWARE to install.

• Wait for completness of installation.

• Exit smit interface by pressing F4 or ESC–4.

• Type: cd /usr/Adobe/acrobat.

• Type ./INSTALL and follow instructions for installation. By default, Acrobat Reader binary
is installed in /usr/lpp/Acrobat3/bin directory. You can view the KM User Guide by typing:
/usr/lpp/Acrobat3/bin/acroread /mnt/BCL_User_Guide.pdf.

Installing Acrobat Reader for Windows NT
• Insert the HACMP Cluster Management CD–ROM into your drive.

• Double Click on your CD–ROM icon (into your Desktop).

• Change directory to Acrobat\NT.

• Double click on ”rs405eng” icon and follow instructions for installation (a reboot of your
system is recommended). An ”Acrobat Reader” icon appears in your Windows NT
desktop.

• Double click on it to start Acrobat Reader and open BCL_User_Guide.pdf file in your
CD–ROM drive directory to view the KM User Guide.

Installing Acrobat Reader for Unix (except AIX)
Acrobat Reader software is not included in the HACMP Cluster Management CD–ROM

• Download Acrobat Reader for your operating system from Adobe worl wide web site:
http://www.adobe.com.

• Follow the instructions for installation.
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Resetting Event Alarms
After loading HACMP Cluster Management KM, the cluster node agent enters a discovery
phase. All KM applications will be displayed, when the appropriate information has been
would be collected (some minutes could be necessary to collect all information).

In some cases, alarms could be detected about HACMP events (BCL_EVENT application
instances). This means that there have been events that were in an alarm state or had still
been running a long time ago.

You can use menu commands for events to determine the cause of the alarm.

Refer to your HACMP administrator to verify that the problem no longer exists.

Then use can you the “Reset Alarm” menu command from BCL_EVENT application to
cancel these alarms.

For example, just after having installed the HACMP Cluster Management on my cluster, an
alarm indicates that the “config_too_long” event is running. Using the “last lines for this
event” menu command, it is easy to understand that this alarm has occured several days
previously and is no longer applicable. Verifying this fact with the HACMP administrator. I
can use the “Reset Alarm” menu command to cancel it.

Deinstalling HACMP Cluster Management KM for Patrol
Before deinstalling the KM, make sure to delete all HACMP Cluster Management KM files
on PATROL consoles using it.

To delete KM files from a PATROL console:

Step 1 Choose Attributes => Application Classes from the PATROL Console menu bar.

A list of KM files loaded on your console appears.

Step 2 Click on any KM file beginning by the prefix “BCL_”.

Step 3 Choose Edit => Delete from the menu bar.

Step 4 Click “yes” in the deletion confirmation window.

Step 5 Repete from the step 2 until you have no KM file beginning by the prefix “BCL_”.

HACMP Cluster Management KM deinstallation is done manually by removing all files
included in the Knowledge Module.

If you want to deinstall the HACMP Cluster Management KM for PATROL:

Log in PATROL user

Change directory to $PATROL_HOME

Remove:

.lib/psl/BCL_* files

./lib/knowledge/BCL_* files

• For a PATROL Agent configuration:

./BCL_KM directory

./remote/BCL_shared_info directory

• For an UNIX PATROL Console configuration:

./lib/images/BCL_*

./lib/help/BCL_help.hlp file

./lib/help/BCL_help directory
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• For a NT PATROL Console configuration:

.\lib\images\BCL_*

.\lib\help\WinHelp\BCL_help.*

To remove completely HACMP Cluster Management KM from your system, on AIX
platforms, remove “bullcluster.kmpatrol” package:

Type: smit remove

Press F4 or Esc–4 to choose fileset to remove

Select “bullcluster.kmpatrol“ package

Enter “no” for PREVIEW only field

Exit from smit when the operation is complete

Where to Go from Here

The following table suggests topics that you should read next:

if you want information on... See...

What a certain menu command does Chapter 3, “Menu Summary” and the help.

What a certain parameter does Chapter 4, “Parameter Summary” and the help.

How HACMP Configuration element are 
represented

Chapter 5, “HACMP Cluster Management
Specificities” and the help.

The tasks you can perform with the HACMP Cluster
Management Knowledge Module for PATROL

Chapter 6, “Using the HACMP Cluster Management
KM for PATROL” and the help.

Event messages Chapter 7, “Event Messages” and the help.
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Chapter 3. Menu Summary

This chapter summarizes the menus and menu commands for the PATROL Knowledge
Module � for HACMP.

The following topics are discussed in this chapter:

• BCL_ADAPTER Menu 3-1

• BCL_APPLICATIONSERVER Menu 3-1

• BCL_CLUSTER  Menu 3-2

• BCL_COLLECT  Menu 3-3

• BCL_EVENT Menu 3-4

• BCL_FILESYSTEM Menu 3-4

• BCL_HACMP Menu 3-5

• BCL_NETWORK Menu 3-7

• BCL_NODE Menu 3-7

• BCL_PHYSICALVOLUME Menu 3-7

• BCL_RESOURCEGROUP Menu 3-8

• BCL_RESOURCES Menu 3-8

• BCL_VOLUMEGROUP Menu 3-8

BCL_ADAPTER Menu
To access the BCL_ADAPTER menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_ADAPTER icon.

• With the PATROL Console for Windows NT, right–click the BCL_ADAPTER icon.

The BCL_ADAPTER menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance.

BCL_APPLICATIONSERVER Menu
To access the BCL_APPLICATIONSERVER menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the
BCL_APPLICATIONSERVER icon.

• With the PATROL Console for Windows NT, right–click the
BCL_APPLICATIONSERVER icon.

The BCL_APPLICATIONSERVER menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance.
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BCL_CLUSTER Menu
To access the BCL_CLUSTER menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_CLUSTER icon.

• With the PATROL Console for Windows NT, right–click the BCL_CLUSTER icon.

The BCL_CLUSTER menu has the following menu commands:

Menu Command Action

Verify Cluster Verifies HACMP configuration of the cluster

Show Topology Displays cluster topology

Configure Monitored Items Configures monitoring for instances 
depending on the cluster (adapters, 
networks, nodes, resourcegroups)

Adapters Configures adapter instances monitoring for
the entire cluster

Set Maximum Number Monitored Configures a maximum number of adapter
instances to display for the entire cluster. 
This command is only available from a
PATROL developer console

Set Pattern Not Monitored Configures a pattern of adapter instances
not to display for the entire cluster. 
This command is only available from a
PATROL developer console

Networks Configures network instances monitoring for
the entire cluster

Set Maximum Number Monitored Configures a maximum number of network
instances to display for the entire cluster. 
This command is only available from a 
PATROL developer console

Set Pattern Not Monitored Configures a pattern of network instances
not to display for the entire cluster. 
This command is only available from a
PATROL developer console

Nodes Configures node instances monitoring for
the entire cluster

Set Maximum Number Monitored Configures a maximum number of node 
instances to display for the entire cluster. 
This command is only available from a 
PATROL developer console

Set Pattern Not Monitored Configures a pattern of node instances not
to display for the entire cluster. 
This command is only available from a
PATROL developer console
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Resource Groups Configures resource group instances 
monitoring for the entire cluster

Set Maximum Number Monitored Configures a maximum number of resource
group instances to display for the entire
cluster. 
This command is only available from a 
PATROL developer console

Set Pattern Not Monitored Configures a pattern of resource group 
instances not to display for the entire cluster.
This command is only available from a
PATROL developer console

BCL_COLLECT Menu
To access the BCL_COLLECT menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_COLLECT icon.

• With the PATROL Console for Windows NT, right–click the BCL_COLLECT icon.

The BCL_COLLECT menu has the following menu commands:

Menu Command Action

Refresh Refreshes HACMP Cluster Management KM collector
parameters values and launches application discovery

ALL Refreshes all collector parameters values and starts
discovery for each HACMP Cluster Management KM
application

HACMP Configuration Refreshes COLL_HACMP collector parameter values

Local Resources Refreshes COLL_Errlog, COLL_Disk, COLL_Event,
COLL_LVM, COLL_PROCESS collector parameters
values and starts discovery for BCL_HACMP,
BCL_EVENT, BCL_RESOURCES,
BCL_VOLUMEGROUP, BCL_PHYSICALVOLUME,
BCL_APPLICATIONSERVER applications

Network Informations Refreshes COLL_Network, COLL_PROCESS collector
parameters values and starts discovery for 
BCL_CLUSTER, BCL_NETWORK, BCL_ADAPTER,
BCL_RESOURCEGROUP, BCL_NODE applications

Display KM Log Creates a report for information search through HACMP
Cluster Management KM log

Trace KM Log Allows dynamic display of HACMP Cluster Management
KM log

� � � � � � � � � � �
� � � � � � � � � � �
� � � � � � � � � � �
� � � � � � � � � � �

Enable KM Log Trace Activates the text parameter COLL_KMLog which 
produces a dynamic report that shows new lines added
in HACMP Cluster Management KM log� � � � � � � � � � �

� � � � � � � � � � �Disable KM Log Trace Deactivates the text parameter COLL_KMLog

Set KM Debug Set debugging for HACMP Cluster Management KM� � � � � � � � � � �
� � � � � � � � � � �
� � � � � � � � � � �
� � � � � � � � � � �

Normal Mode Set debugging mode to normal: only messages for
PATROL object management are stored in HACMP
Cluster Management KM log. No display in system 
ouput.
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� � � � � � � � � � �
� � � � � � � � � � �
� � � � � � � � � � �

Verbose Mode Set debugging mode to verbose: all debug messages
are stored in HACMP Cluster Management KM log and
also displayed in system output.

Set KM Log Size Allows you to change maximum size of HACMP Cluster
Management KM log

BCL_EVENT Menu
To access the BCL_EVENT menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_EVENT icon.

• With the PATROL Console for Windows NT, right–click the BCL_EVENT icon.

The BCL_EVENT menu has the following menu commands:

Menu Command Action

Last Lines for this event Generates a report containing lines of last occurence of
this event in more recent hacmp.out HACMP log where
event has started

All lines for this event Generates a report containing all lines for this event in
more recent hacmp.out HACMP log where event has
started

Reset Alarm Allows you to manually stop the alarm for the event.
Can be done if you have corrected problem on the 
system in the alarm state and the event still appears in
the alarm  state

Stop Monitoring Stops monitoring the selected instance

BCL_FILESYSTEM Menu
To access the BCL_FILESYSTEM menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_FILESYSTEM
icon.

• With the PATROL Console for Windows NT, right–click the BCL_FILESYSTEM icon.

The BCL_FILESYSTEM menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance
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BCL_HACMP Menu
To access the BCL_HACMP menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_HACMP icon.

• With the PATROL Console for Windows NT, right–click the BCL_HACMP icon.

The BCL_HACMP menu has the following menu commands:

Menu Command Action

Show Topology Displays the topology of the node 
corresponding to the current system

Display Logs Generates reports for the selected logs

Display cluster.log Generates report on cluster.log HACMP log
with keywords given and without exclusion
keywords

Display hacmp.out Generates report on selected hacmp.out
HACMP log with keywords given and 
without exclusion keywords

System Errlog Generates report on system error log with key-
words given and without exclusion keywords

Trace Logs Allows dynamic display of HACMP logs

cluster.log Allows dynamic display of cluster.log
HACMP log

Enable Log Trace Activates the text parameter HACMP_Clus-
terLog which produces a dynamic report that
shows new lines added in cluster.log
HACMP log

Disable Log Trace Deactives the text parameter HACMP_Clus-
terLog

hacmp.out Allows dynamic display of latest hacmp.out
HACMP log

Enable Log Trace Activates the text parameter HACMP_Out
which produces a dynamic report that shows
new lines added in latest hacmp.out HACMP
log

Disable Log Trace Deactives the text parameter HACMP_Out

Maintenance Mode Sets maintenance mode for the system

Enable Maintenance Mode Activates maintenance mode for the system

Disable Maintenance Mode Deactivates maintenance mode for the
system
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Menu Command Action

Configure Monitored Items Configures monitoring for instances 
depending on the node (application servers,
events, filesystems, physical volumes, 
resources, volume groups)

Application Servers Configures application server instances 
monitoring for the node

Set Maximum Number Monitored Configures a maximum number of 
application server instances to display for
the node.
This command is only available from a 
PATROL developer console

Set Pattern Not Monitored Configures a pattern of application server
instances not to display for the node. 
This command is only available from a
PATROL developer console

Events Configures event instances monitoring for
the node

Set Maximum Number Monitored Configures a maximum number of event 
instances to display for the node. 
This command is only available from a
PATROL developer console

Set Pattern Not Monitored Configures a pattern of event instances not
to display for the node. 
This command is only available from a 
PATROL developer console

Filesystem Configures filesystem instances monitoring
for the node

Set Maximum Number Monitored Configures a maximum number of filesystem
instances to display for the node. 
This command is only available from a
PATROL developer console

Set Pattern Not Monitored Configures a pattern of filesystem instances
not to display for the node. 
This command is only available from a 
PATROL developer console

Physical Volumes Configures physical volume instances 
monitoring for the node

Set Maximum Number Monitored Configures a maximum number of physical
volume instances to display for the node. 
This command is only available from a
PATROL developer console

Set Pattern Not Monitored Configures a pattern of physical volume 
instances not to display for the node. 
This command is only available from a 
PATROL developer console

Resources Configures resource instances monitoring
for the node

Set Maximum Number Monitored Configures a maximum number of resource
instances to display for the node. 
This command is only available from a
PATROL developer console
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Menu Command Action

Set Pattern Not Monitored Configures a pattern of resource instances
not to display for the node. 
This command is only available from a 
PATROL developer console

Volume Groups Configures volume group instances 
monitoring for the node

Set Maximum Number Monitored Configures a maximum number of volume
group instances to display for the node. 
This command is only available from a
PATROL developer console

Set Pattern Not Monitored Configures a pattern of volume group 
instances not to display for the node. This
command is only available from a 
PATROL developer console

Remote Users Configuration Allows access configuration for remote
users on this node. 
This command is only available from a
PATROL developer console

Set Primary Node Allows user to specify which node would
show cluster information among all nodes, if
available. 
This command is only available from a
PATROL developer console

BCL_NETWORK Menu
To access the BCL_NETWORK menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_NETWORK icon.

• With the PATROL Console for Windows NT, right–click the BCL_NETWORK icon.

The BCL_NETWORK menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance.

BCL_NODE Menu
To access the BCL_NODE menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_NODE icon.

• With the PATROL Console for Windows NT, right–click the BCL_NODE icon.

The BCL_NODE menu has the following menu commands:

Menu Command Action

Show Local Resources Problems Displays instances in alarm or warning state

Stop Monitoring Stops monitoring the selected instance

BCL_PHYSICALVOLUME Menu
To access the BCL_PHYSICALVOLUME menu, perform one of the following actions:
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• With the PATROL Console for Unix, click and hold MB3 on the
BCL_PHYSICALVOLUME icon.

• With the PATROL Console for Windows NT, right–click the BCL_PHYSICALVOLUME
icon.

The BCL_PHYSICALVOLUME menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance

BCL_RESOURCEGROUP Menu
To access the BCL_RESOURCEGROUP menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the
BCL_RESOURCEGROUP icon.

• With the PATROL Console for Windows NT, right–click the BCL_RESOURCEGROUP
icon.

The BCL_RESOURCEGROUP menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance

BCL_RESOURCES Menu
To access the BCL_RESOURCES menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_RESOURCES
icon.

• With the PATROL Console for Windows NT, right–click the BCL_RESOURCES icon.

The BCL_RESOURCES menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance

BCL_VOLUMEGROUP Menu
To access the BCL_VOLUMEGROUP menu, perform one of the following actions:

• With the PATROL Console for Unix, click and hold MB3 on the BCL_VOLUMEGROUP
icon.

• With the PATROL Console for Windows NT, right–click the BCL_VOLUMEGROUP
icon.

The BCL_VOLUMEGROUP menu has the following menu commands:

Menu Command Action

Stop Monitoring Stops monitoring the selected instance
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Where to Go from Here

The following table suggests topics that you should read next:

if you want information on... See...

What a certain parameter does Chapter 4, “Parameter Summary” and the help.

How HACMP Configuration element are 
represented

Chapter 5, “HACMP Cluster Management
Specificities” and the help.

The tasks you can perform with the HACMP Cluster
Management Knowledge Module for PATROL

Chapter 6, “Using the HACMP Cluster Management
KM for PATROL” and the help.

Event messages Chapter 7, “Event Messages” and the help.
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Chapter 4. Parameters

This chapter describes the parameters used in the PATROL Knowledge Module � for
HACMP.

The following topics are discussed in this chapter:

• Functional Parameter Summary 4-2

• Parameter Defaults 4-5

• Collector–Consumer Dependencies 4-8
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Functional Parameter Summary
The PATROL KM for HACMP has various parameters that provide statistical information
about resources, operating status and performance.

The following table provides information that you can use when selecting or reviewing the
parameters that are used in monitoring.

It lists application classes and parameters alphabetically.

Table 3. Functional Parameters

Parameter Description

BCL_ADAPTER Application Class

ADAP_State State of adapter:  0=Down, 1=Up

BCL_APPLICATIONSERVER Application Class

BCL_CLUSTER Application Class

CL_MaxNetwork Indicates that all the BCL_NETWORK application instances are not
monitored by the PATROL Agent on the node.

CL_MaxNode Indicates that all the BCL_NODE application instances are not moni-
tored by the PATROL Agent on the node.

CL_MaxRG Indicates that all the BCL_RESOURCEGROUP application instances
are not monitored by the PATROL Agent on the node.

CL_NetworkNotMonitored Indicates the BCL_NETWORK applications instances are not moni-
tored by the PATROL Agent on the node.

CL_NodeNotMonitored Indicates the BCL_NODE applications instances are not
monitored by the PATROL Agent on the node.

CL_RGNotMonitored Indicates the BCL_RESOURCEGROUP applications instances are
not monitored by the PATROL Agent on the node.

BCL_COLLECT Application Class

COLL_Disk Retrieves information about disks: verifies access to disks and reports
system errors about disks.

COLL_Errlog Retrieves system error logs.

COLL_Event Retrieves information about Events.

COLL_HACMP Retrieves information about HACMP configuration.

COLL_KMLog Provides text windows for KM log file trace.

COLL_LVM Retrieves information about LVM (logical volume manager).

COLL_LogWarning Indicates the HACMP Cluster Management KM log maximum size has
been reached.

COLL_Network Retrieves information about adapter availability.

COLL_Process Retrieves information about HACMP processes.

BCL_EVENT Application Class

EV_State Represents state of event
 0=complete, 1=started, 2=potential  error of event.

EV_TimeElapsed Represents time elapsed since last start. 
This parameter is set up to zero if Event passes in state COM-
PLETED.
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Parameter Description

BCL_FILESYSTEM Application Class

FS_FreeSpace Represents free 512bytes blocks for this Filesystem

FS_SpaceUsed Represents percentage of used blocks in Filesystem

FS_State Indicates status of the filesystems. 0=unmounted, 1=mounted.

BCL_HACMP Application Class

ExtraFilesList Specifies a list of files mandatory to the HACMP Cluster
Management KM for Patrol comittment, especially libraries for the KM.

HACMP_ClusterLog Provides traces about cluster.log log file

HACMP_EventNotMonitored Indicates the BCL_EVENT applications instances not monitored by
the PATROL Agent on the node.

HACMP_MaxEvent Indicates that all the BCL_EVENT applications instances are not
monitored by the PATROL Agent on the node.

HACMP_MaxResources Indicates that all the BCL_RESOURCES applications instances are
not monitored by the PATROL Agent on the node.

HACMP_Out Provides traces about hacmp.out log file

HACMP_ResourcesNotMonitored Indicates the BCL_RESOURCES applications instances are not 
monitored by the PATROL Agent on the node.

BCL_NETWORK Application Class

NET_AdapterNotMonitored Indicates the BCL_ADAPTER applications instances are not 
monitored by the PATROL Agent on the node.

NET_MaxAdapter Indicates that all the BCL_ADAPTER applications instances are not
monitored by the PATROL Agent on the node.

BCL_NODE Application Class

NODE_LocalRes State of local Resources on Node 
(This parameter is disabled in maintenance mode)

NODE_PatrolAgent State of Patrol Agent on Node 
(This parameter is disabled in maintenance mode only if Node is 
unreachable)

NODE_Services State of HACMP services on Node 
(This parameter is disabled in maintenance mode)

NODE_State State of Node 1=reachable,  3=unreachable.

BCL_PHYSICALVOLUME Application Class

PV_State Indicates state of Physical Volume: OFFLINE=not activated
OK = available for Resources on this Node 
ALARM = an error has occured

BCL_RESOURCEGROUP Application Class

RG_State Indicates state of this Resource Group. 
Values : 0=not running,  1=running normaly, 
             2=running not on its original node,  3=error.

BCL_RESOURCE Application Class

RES_AppServNotMonitored Indicates the BCL_APPLICATIONSERVER application instances are
not monitored by the PATROL Agent on the node.

RES_MaxAppServ Indicates that all the BCL_APPLICATIONSERVER applications
instances are not monitored by the PATROL Agent on the node.

RES_MaxVG Indicates that all the BCL_VOLUMEGROUP applications instances
are not monitored by the PATROL Agent on the node.

RES_ServAddr Service address availability. 
If no Service address is defined for the associated Resource Group,
this parameter is not available.
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Parameter Description

RES_VGNotMonitored Indicates the BCL_VOLUMEGROUP applications instances are not
monitored by the PATROL Agent on the node.

BCL_VOLUMEGROUP Application Class

VG_FilesystemNotMonitored Indicates the BCL_FILESYSTEM applications instances are not 
monitored by the PATROL Agent on the node.

VG_FreeSpace Shows percentage of free space left on the volumegroup.

VG_MaxFilesystem Indicates that all the BCL_FILESYSTEM applications instances are
not monitored by the PATROL Agent on the node.

VG_MaxPhysicalVolume Indicates that all the BCL_PHYSICALVOLUME applications instances
are not monitored by the PATROL Agent on the node.

VG_PVNotMonitored Indicates the BCL_PHYSICALVOLUME applications instances are not
monitored by the PATROL Agent on the node.

VG_State Indicates status of volume group. 0=deactivated, 1=activated

See also Table 4 Parameter default, on page 4-6
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Parameter Default Values

The following table lists default values of parameters. Interpret the column headings as
follows. Some information is not applicable for a particular parameter; these instances are
denoted by N/A in the table.

Parameter specifies the parameter name.

Active? specifies whether the parameter is active or inactive when 
discovered.

Type specifies whether the parameter is a standard (Std.), 
a Consumer (Con.), or a Collector (Coll.) parameter.

Alarm 1 specifies the threshold for the first alarm. 
This information is not applicable to collector parameters.

Alarm 2 specifies the threshold for the second alarm. 
This information is not applicable to collector parameters.

Border Alarm specifies the threshold for border alarms. 
This information is not applicable to collector parameters.

Scheduling specifies the time interval in the poll cycle. 
This information  is not applicable to consumer parameters.
The time is expressed in seconds unless otherwise stated.

Icon specifies whether the icon is a graph, gauge, text box, 
check box (boolean), or stoplight.

Units specifies the type of unit in which the parameter output is expressed,
such as a percentage, a number, text, Boolean, kilobytes 
or megabytes, seconds, milliseconds, minutes.

Annotated? specifies whether the parameter is annotated.
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Table 4. Parameter default
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ADAP_State Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

CL_MaxNetwork N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

CL_MaxNode N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

CL_MaxRG N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

CL_NetworkNotMonitored N (1) Con. N/A N/A N/A none Text N/A  N

CL_NodeNotMonitored N (1) Con. N/A N/A N/A none Text N/A  N

CL_RGNotMonitored N (1) Con. N/A N/A N/A none Text N/A  N

COLL_Disk  Y Coll. 2 to 2 N/A N/A 600 Stoplight N/A  N

COLL_Errlog  Y Coll. 2 to 2 N/A N/A 60 Stoplight N/A  N

COLL_Event  Y Coll. 2 to 2 N/A N/A 300 Stoplight N/A  N

COLL_HACMP  Y Coll. 2 to 2 N/A N/A 300 Stoplight N/A  N

COLL_KMLog N (2) Coll. N/A N/A N/A none Text N/A  N

COLL_LVM  Y Coll. 2 to 2 N/A N/A 300 Stoplight N/A  N

COLL_LogWarning N (3) Coll. 0 to 0 1 to 1 N/A none Stoplight N/A  N

COLL_Network  Y Coll. 2 to 2 N/A N/A 60 Stoplight N/A  N

COLL_Process  Y Coll. 2 to 2 N/A N/A 60 Stoplight N/A  N

EV_State  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

EV_TimeElapsed  Y Con. 4003 to
5000

2508to
4003

0–5000 none Graph Seconds  N

FS_FreeSpace  Y Con. 0 to 50 50to
100

N/A none Graph Mbytes  N

FS_SpaceUsed  Y Con. 80to90 90to
100

N/A none Gauge %  N

FS_State  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

ExtraFilesList  N Con. N/A N/A N/A none Text N/A  N

HACMP_ClusterLog N (2) Con. N/A N/A N/A none Text N/A  N

HACMP_EventNotMoni-
tored

N (1) Con. N/A N/A N/A none Text N/A  N

HACMP_MaxEvent N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

HACMP_MaxResources N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

HACMP_Out N (2) Con. N/A N/A N/A none Text N/A  N

HACMP_ResourcesNotMo-
nitored

N (1) Con. N/A N/A N/A none Text N/A  N

NET_AdapterNotMonitored N (1) Con. N/A N/A N/A none Text N/A  N

NET_MaxAdapter N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

NODE_LocalRes  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

NODE_PatrolAgent  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

NODE_Services  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

NODE_State  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N
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PV_State  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

RG_State  Y Con. 2 to 2 2 to 3 N/A none Stoplight N/A  N

RES_AppServNotMoni-
tored

 N Con. N/A N/A N/A none Text N/A  N

RES_MaxAppServ  N Con. 1to100 N/A 0–100 none Stoplight N/A  N

RES_MaxVG  N Con. 1to100 N/A 0–100 none Stoplight N/A  N

RES_ServAddr Y (4) Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

RES_VGNotMonitored  Y Con. N/A N/A N/A none Text N/A  N

VG_FilesystemNotMoni-
tored

N (1) Con. N/A N/A N/A none Text N/A  N

VG_FreeSpace N (1) Con. 0to10 10to20 N/A none Gauge %  N

VG_MaxFilesystem N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

VG_MaxPhysicalVolume N (1) Con. 1to100 N/A 0–100 none Stoplight N/A  N

VG_PVNotMonitored N (1) Con. N/A N/A N/A none Text N/A  N

VG_State  Y Con. 2 to 2 3 to 3 N/A none Stoplight N/A  N

See also Table 3 Functional Parameter Summary, on page 4-4

(1) Activated only if not all instances of indicated type are monitored.

(2) Activated by uses, with appropriate menu command.

(3) Activated if HACMP Cluster Management KM log file size is greater than configured
maximum size.

(4) Present only into resources owned by resource groups where an IP address is
defined.
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Collector–Consumer Dependencies
Many of the parameters in the PATROL KM are consumer parameters. Consumer
parameters depend on a collector parameter, or a standard parameter used as a collector,
to set their value or to collect information.

Disabling a collector parameter also disables the dependent consumer parameter.

The following table lists of the collector parameters and their dependent consumer
parameters.

Consumer
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Poll Time (in seconds) 600 60 300 300 300 60 60

ADAP_State X

CL_MaxNetwork X

CL_MaxNode X

CL_MaxRG X

CL_NetworkNotMonitored X

CL_NodeNotMonitored X

CL_RGNotMonitored X

COLL_KMLog

COLL_LogWarning X

EV_State X

EV_TimeElapsed X

FS_FreeSpace X

FS_SpaceUsed X

FS_State X

ExtraFilesList

HACMP_ClusterLog

HACMP_EventNotMoni-
tored

X

HACMP_MaxEvent X

HACMP_MaxResources X

HACMP_Out

HACMP_ResourcesotMo-
nitored

X

NET_AdapterNotMoni-
tored

X

NET_MaxAdapter X

NODE_LocalRes X

NODE_PatrolAgent X

NODE_Services X

NODE_State X
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Consumer
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PV_State X

RG_State X

RES_AppServNotMoni-
tored

X

RES_MaxAppServ X

RES_MaxVG X

RES_ServAddr X

RES_VGNotMonitored X

VG_FilesystemNotMoni-
tored

X

VG_FreeSpace X

VG_MaxFilesystem X

VG_MaxPhysicalVolume X

VG_PVNotMonitored X

VG_State X
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Chapter 5. HACMP Cluster Management Specificities

This chapter describes how HACMP Cluster Management KM works, how it represents
HACMP configuration elements, its concepts and its functionalities.

The following topics and procedures are explained:

Understanding Display of the HACMP Cluster Management KM Icons 5-2

Election of a Primary Node 5-5

Maintenance Mode 5-6

Monitoring Functions 5-7

Debugging 5-8

About performances 5-9
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Understanding Display of the HACMP Cluster Management KM Icons
For understanding how the HACMP Cluster Management KM represents elements of a
cluster, we will work on a real HACMP configuration.

“Jean” and “Reno” are two RS6000 platforms. They access concurrently to a shared Oracle
database. They have access to an ethernet public network and a fddi private network.

To warrant high availability of this configuration, HACMP has been installed and configured
as followed.

The cluster name is “visiteur”.

It has two nodes: “jean” and “reno”.

They are connected to a public network: “ETH_PUB”, and to a private network
“INTERCONNECT”.

Adapter to connect to “jean” when HACMP is not running is “jean_boot” (boot adapter).

Adapter to connect to “jean” when HACMP is running is “jean_srv” (service adapter).

Adapter to connect to “jean” when service adapter is not available is “jean_stby” (stanby
adapter)... and so on for node “reno”

About applications:

Oracle must run on both nodes, but the database can either be accessed through “jean” or
“reno”.

3 resource groups are created:

• HA1rg containing service adresse of “jean”: type cascading

• HA2rg containing service adresse of “reno”: type cascading

• ORArg (type concurrent) containing application server “ORA_as” (starts and stops Oracle
application) and volume groups shared for Oracle database: ORA1vg, ORA2vg, ORA3vg.
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For the example described above, the representation is:

Instances contained in the cluster are: Locally to a node, supervised elements are:

What is contained by these resource groups are named “resources” in the KM, and
represented locally on each node, because the state of these objects is only available on
the nodes owning them. Similarly, HACMP events are local to the nodes.

In order to supervise more closely the Logical Volume Manager elements, the KM also
observes all components of defined physical resources:

• physical volumes containing defined volume groups are represented to detect any
hardware problem.
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• volume groups, if not explicitly defined in HACMP configuration and filesystems indicated,
are represented as parent of defined filesystems.

• however, not explicitly defined filesystems are not shown by the KM.

For the example, locally represented objects are all accessible through System window, via
the HACMP icon.

You can retrieve in the window corresponding to this icon:

Thus, all components of HACMP configuration declared are represented: locally for
resources depending directly of a cluster node or globally, for elements accessed by the
whole cluster (cluster itself, cluster nodes, resource groups, networks and adapters included
in them).
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Moreover, information depending on the HACMP application itself are also included
(events).

Election of a Primary Node
As described in the previous paragraph, there is only one icon representing the cluster at a
moment. This gives a more realistic representation of HACMP concepts and simplifies the
management.

However, for the HACMP application, cluster is an abstract concept joining several systems,
called nodes, to run applications described in the configuration. Which is shared by all
systems included in the cluster, but only one of them must display this information.

In order to give you a unique representation of a cluster, cluster nodes exchange
information to determine which one is the most capable of providing the cluster state. They
process an election of a node which will display all information about the cluster. This node
is called in the HACMP Cluster Management KM: a primary node.

The election mechanism is used by each cluster node, based on the HACMP configuration
(synchronized), and ends with designation of the same cluster node as primary node.

This one is the first node in the HACMP configuration nodes list which is seen by the
greatest number of PATROL consoles. This rule allows you to keep information even if a
node becomes unavailable or if its communication with a PATROL console becomes
impossible.

Note: To permit the election to process normally, all cluster nodes included in a cluster
configuration should be connected to a PATROL console at the same time.

How to know which node is the primary node ?
Open Infobox of cluster instance from BCL_CLUSTER application.

On any cluster node System Output, you can type: %PSL print(get(“/BCL_CLUSTER/
clPrimary”))

How to set manually the primary node ?
A user, from a developer PATROL console, can defined a cluster node as a primary node,
by using the appropriate menu command (see Menu Summary chapter for more detail), or
by defining it in the appropriate configuration variable (see Configuration variables table into
Getting Started chapter).

Election process is used if selected primary node is no longer available.

CAUTION:
If you use this functionality, the rule used for election is no longer used and the primary node
set manually has priority. If your console is not connected to the selected node, you may not
see the cluster instance from BCL_CLUSTER application.

I get several instances of my cluster in main window...
During startup of a PATROL agent or connection of a PATROL console, it takes a short time
to coordinate all cluster node information.

During that time, you can get several icons of your cluster. If the problem persists, verify the
synchronization of your cluster.

I get no instance of my cluster in main window...
During startup of a PATROL agent, no cluster instance is created until all information about
it is collected. Wait until all collector parameters are refreshed.

Several other events could cause the loss or the non–presence of the cluster instance:

• previous primary node has become unavailable: wait until election for primary node
process designs a new primary node.
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• connection with primary node from your PATROL console is not available: try to update
connection. If still unreachable:

– If you have set the primary node manually, the only way to retrieve information is to set
a new primary node manually or to return to the automatic election process (see Menu
Command Summary).

– Otherwise, a new election is in progress. Wait a short time to see your cluster icon.

• PATROL agents on cluster nodes have detected that a new PATROL console is
connecting to them. In that case, wait until shared information between cluster nodes
becomes stable. Then, a new unique primary node will be available, and you will retrieve
all information.

Maintenance Mode
This mode is usable for not reporting alarms about cluster information during a maintenance
operation. For example, if you have decided to make a takeover of a cluster node because it
will be used for an operation that necessitates reboot of the system, entering in
maintenance mode will not show you all alarms generated by this operation on this node.

Under maintenance mode:

• No alarm/warning is generated by stopping HACMP services, nor by local Resources:
parameters NODE_Services and NODE_LocalRes from BCL_NODE application are
always de–activated in maintenance mode (an event indicates that an abnormal state of
the parameter has been detected but cannot be displayed).

• The parameter NODE_PatrolAgent belonging to BCL_NODE application is still managing
warnings on Patrol Agent status on remote Nodes. If Node is unreachable, Node instance
becomes OFFLINE and no more warnings about Patrol Agent status on this node will be
managed.

• Any adapter instance unreachable becomes OFFLINE (an event indicates that an
abnormal state of the adapter has been detected but no alarm is displayed).

• Any service adress used in a Resource Group that becomes unreachable changes status
to OFFLINE (an event indicates that an anormal state of the adapter has been detected
but no alarm displayed).

• All information about Resource Groups are still displayed. For example, if a HACMP
takeover has been done, warnings will be viewed for Resource Groups that have change
of original Node, because they are not in a normal state compared with HACMP
configuration.

As you can see, maintenance mode is practice to mark alarms that have been planned. But
remember that it is a manual operation, and when not necessary, you should not use it, and
return to normal mode when the planned operation has been completed.

How to enter in maintenance mode ?
Use ”Maintenance Mode – Enable Maintenance Mode” menu command of HACMP instance
of BCL_HACMP application.

This command requires root authority on the node to be enabled for maintenance mode.
Confirm your order.

Take care when using this command on the cluster Node representing the Cluster if you
want to hide alarms from adapters, HACMP services and Local Resources. To identify it, in
main Patrol Console window, instance with the choosen cluster name is noted ”<cluster
name> BCL_CLUSTER <node name>”.

You can also open info box of the instance with the choosen cluster name in main Patrol
Console window: node name to select is given by ”Primary Node” information. Then, open
the system window sharing the sane node name, and use menu command of the ”HACMP”
object.
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How to stop maintenance mode ?
Choose node in maintenance mode. Use ”Maintenance Mode – Disable Maintenance
Mode” menu command of HACMP instance of BCL_HACMP application.

How to know if a node is in maintenance mode ?
Open info box of ”HACMP” object in the system window of the selected cluster node. Look
at ”Maintenance Mode” information.

This field indicates whether maintenance mode is “enabled” or “disabled” on this node.

Monitoring Functions: limiting application instances
HACMP Cluster Management KM for PATROL provides you with all facilities to monitor only
PATROL objects you choose.

By default all instances from all application classes are created, but using monitoring
functions, you can hide some application instances.

What applications can be monitored?
All HACMP Cluster Management KM applications can be monitored by limiting the number
of  their instances, except three:

• BCL_CLUSTER: only one instance representing global state of the cluster.

• BCL_COLLECT: only one instance representing state of all collector parameters.

• BCL_HACMP: only one instance representing the HACMP application state locally on a
cluster node.

Each other application instance can be customized not to be displayed on a PATROL
console, for a given node.

How to monitor application instances?
There are three ways to limit the number of application instances:

• ‘Stop Monitoring’ menu: available on each instance, allows you to hide the selected
instance on the node for all PATROL consoles.

Example:

You do not wish to display the application server instance “ORA_AS” from
BCL_APPLICATIONSERVER application class: you use ‘Stop Monitoring’ menu
command available directly onto this item.

• Limiting number of instances from a type: use the ‘Set Monitored Items’ menu command
from BCL_CLUSTER or BCL_HACMP application instances (the parent of instance you
want to limit the number). Then, choose corresponding application instance type in
submenu, and use ‘Set Maximum Number Monitored’ menu command in subsubmenu.

Example:

You want to limit disk instances number to 5.

Parent of physical volume instances is BCL_HACMP. You use ‘Set Monitored Items =>
Physical Volumes => Set Maximum Number Monitored’ menu command from
BCL_HACMP application, then you change maximum number to 5.

• Limiting instances by specifying a pattern of instances not to monitor: use the ‘Set
Monitored Items’ menu command from BCL_CLUSTER or BCL_HACMP application
instances (the parent of instance you want to limit the number). Then, choose the
corresponding application instance type in the submenu, and use ‘Set Pattern not
Monitored’ menu command in subsubmenu.
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The pattern used is a regular expression, like those used by the grep shell command.

Example:

You do not wish to monitor boot adapters (their names are suffixed by “_boot” in your
configuration) or stanby adapters (suffixed by “_stby” in your configuration.

Parent of adapters instances is BCL_CLUSTER. You use ‘Set Monitored Items =>
Physical Volumes => Set Pattern not Monitored’ menu command from BCL_CLUSTER
application, then you change pattern to “.*_boot|.*_stby”.

Debugging
To help you to analyse more finely the HACMP Cluster Management KM reporting, a special
log file is generated in the $PATROL_HOME/log directory. The log file name is BCL_log.
HACMP Cluster Management KM records information about cluster state with two levels of
debugging:

• a normal debugging mode, that is set by default and records Patrol objects state
(creation, deletion and status changes) and consoles information.

• a verbose debugging mode, you can dynamically activate, which stores more details
about new values for variables, event messages generated and application class
discoveries.

This file is automatically managed by HACMP Cluster Management KM to avoid saturation
of user Patrol filesystem : a variable (set by default to 100 Kb) can be changed to set a
maximum log size for this file. If log file size passes this trigger, log is copied into a ”.bak” file
and a new log is started. 
Take care, however, to set maximum log file size to an appropriate number according to
your debugging mode (it is recommended not to set maximum log size less than 500Kb if
you use verbose debugging model. This file can be traced using menu commands (see
below).

How to display information in log file ?
• Use ”Display KM Log” menu command of BCL_COLLECT application.

• Choose  the number of ending lines you want to display (default is the whole file).

• Optionally choose keywords to search in these lines.

• Optionally choose exception keywords.

• Press OK.

A text window is generated with the result of this command.

How to trace log file ?
You can trace the KM log file using the ”Trace KM LOG – Enable Log Trace” menu
command of BCL_COLLECT application.

The COLL_KMLog parameter under BCL_COLLECT instance is activated.

When double clicking on it, you open a text window that displays new lines generated in the
KM log file.

Take care to close this window, if you do not wish to lose previous information in it (Patrol
creates a new window and erases buffered information in it).

To stop trace, use the ”Trace KM LOG – Disable Log Trace” menu command of
BCL_COLLECT application: the COLL_KMLog parameter under BCL_COLLECT instance is
desactivated.

How to change debugging mode ?
Use ”Set KM Debug” menu command of BCL_COLLECT application. 
Choose ”Normal Mode” or ”Verbose Mode” in submenus.
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How to know the debugging mode ?
Open info box of BCL_HACMP object in the system window. Look at ”Debug Mode”
information.

How to show maximum log file size ?
Open info box of BCL_COLLECT application and see ”KM Log Maximum Size” information.
Or you can look after the ”BCL_KM_Max_Log_Size” variable in $PATROL_HOME/lib/
BCL/BCL.conf file.

How to change maximum log file size ?
Use ”Set KM Log Size” menu command of BCL_COLLECT application. Enter the new
maximum log file size and press OK.

About Performances
During its conception, a great effort has been dedicated to make HACMP Cluster
Management KM for Patrol easier to supervise the HACMP application, retaining
management of all components of clusters.

HACMP Cluster Management Knowledge Module for Patrol is dedicated to the supervision
of HACMP clusters. Considering that this administration tool must not take CPU and
memory resources of running critical applications, it has been built not to take a minimum of
system resources during its execution.

However, in view of the large number of components managed by this KM, Patrol Agent
can use more resources during startup, in particular the parameter PAWorkRateExecsMin of
PATROLAGENT application class from Unix KM could enter into an alarm state; this is
temporary and will return to normal after a few minutes.

This increase of resources usage could also appear during HACMP configurations and
problems. A great number of parameters and information are modified, causing the KM to
refresh all this information. Considering these events are not usual for an HACMP cluster
and that this state does not last more than few minutes, it will not disturb administration of
your clusters.

If you still have problems with performance, for example with the cumulated resources
consummation of other installed KM, you could:

• tune HACMP Cluster Management KM collector parameters in BCL_COLLECT
application class. Increasing default polltime for these parameters, you will launch
executables for cluster state with more time between and therefore decrease KM
resource consummation.

• tune other KM collector parameters. For the same reasons explained above, you will
improve the critical application resources share.

• reduce the number of KM application instances by using monitoring functions.

• increase alarm rates for parameter PAWorkRateExecsMin of PATROLAGENT application
class from Unix KM.
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Chapter 6. Using the HACMP Cluster Management KM
for PATROL

This chapter describes tasks that you can perform with the HACMP Cluster Management
Knowledge Module for PATROL.

The following topics and procedures are explained:

Display Logs 6-2

Show Topology 6-8

Trace Logs 6-12

Maintenance Mode 6-18

Monitoring Functions 6-22

Primary Node 6-32

Configure Remote Accesses 6-35

Refreshing information 6-37

Display KM log 6-42

Tracing KM log 6-44

Stop Tracing KM log 6-46

Debugging Mode 6-47

Changing HACMP Cluster Management KM log size 6-50

Verifying Cluster Topology 6-52

Event Monitoring 6-54

Localizing Local Resources problems in cluster 6-59
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Display Logs
The following steps explain how to display the different logs for HACMP reporting.

Display cluster.log

Step 1

Choose Display Logs => Display cluster.log from BCL_HACMP application menu.

Step 2

From the next window, indicate the number of latest lines in this file you want to display
(default is the whole file).

Optionally, you can indicate a keyword to search in lines and/or a keyword to avoid.

When user choices are defined, press the Accept button.

Note: Take care of the number of lines to display. Result windows are limited by a buffer,
whose size is 500Kb by default.

Limit the number of lines to display or change buffer size in main PATROL console options.
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Step 3

The command output window appears.

Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in the window containing BCL_HACMP icon.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.
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Display hacmp.out

Step 1

Choose Display Logs => Display hacmp.out from BCL_HACMP application menu.

Step 2

From the next window, choose the hacmp.out from all available in /tmp filesystem.

This file is a log for HACMP activity and is stored daily (if HACMP is started).

All logs are sorted by date: the most recent is top of the list (normally “hacmp.out”).

So, if you want to show information about HACMP activity from the day before, you will
choose “hacmp.out.1”.

Indicate the number of latest lines in this file you want to display (default is the whole file).

Optionally, you can indicate a keyword to search in lines and/or a keyword to avoid.

When user choices are defined, press the Accept button.

Note: Take care of the number of lines to display. Result windows are limited by a buffer,
whose size is 500Kb by default. Limit number of lines to display or change buffer
size in main PATROL console options.
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Step 3

The command output window appears.

Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in window containing BCL_HACMP icon.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.
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System Errlog

Step 1

Choose Display Logs => System Errlog from BCL_HACMP application menu.

Step 2

From the next window, choose the hacmp.out from all available in /tmp filesystem.

This file is a log for HACMP activity and is stored daily (if HACMP is started).

All logs are sorted by date: the most recent is top of the list (normally “hacmp.out”).

So, if you want to show information about HACMP activity from the day before, you will
choose “hacmp.out.1”.

Indicate the number of latest lines in this file you want to display (default is the whole file).

Optionally, you can indicate a keyword to search in lines and/or a keyword to avoid.

When user choices are defined, press Accept button.

Note: Take care of number of lines to display. Result windows are limited by a buffer,
whose size is 500Kb by default. Limit number of lines to display or change buffer
size in main PATROL console options.



6-7Using the HACMP Cluster Management KM for PATROL

Step 3

The command output window appears.

Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in window containing BCL_HACMP icon.

You can destroy it by clicking on this icon with the right mouse button and selecting Destroy
menu.
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Show Topology
The following steps explain how to get the topology information defined in HACMP
configuration.

The menu is available through two applications: BCL_CLUSTER and BCL_HACMP.

Show cluster topology

Step 1

Choose Show Topology from BCL_CLUSTER application menu.

Step 2

The login and password dialog box appears.

Step 3

The command output appears and is dynamically updated as the show topology command
is running.
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Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in the window containing main PATROL window.

You can destroy it by clicking on this icon with the right mouse button and selecting Destroy
menu.



6-10 HACMP Cluster Management Knowledge Module� User Guide

Show topology for a given node

Step 1

Choose Show Topology from BCL_HACMP application menu.

Step 2

The login and password dialog box appears.

Step 3

The command output appears and is dynamically updated as the show topology command
is running.
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Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in window containing BCL_HACMP icon (system
window).

You can destroy it by clicking on this icon with the right mouse button and selecting Destroy
menu.
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Trace Logs
The following steps explain how to get/stop the dynamic update of HACMP logs.

This allows you to follow HACMP activity and to track potential problems.

Tracing cluster.log

Step 1

Choose Trace Logs => cluster.log => Enable Log Trace from BCL_HACMP application
menu.

Step 2

The HACMP_ClusterLog text parameter appears into BCL_HACMP window.
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Step 3

Double click on HACMP_ClusterLog to open a text window containing lines of cluster.log
HACMP log, updated dynamically as the file is filled.
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Stop tracing cluster.log

Step 1

Choose Trace Logs => cluster.log => Disable Log Trace from BCL_HACMP application
menu.

Step 2

The HACMP_ClusterLog text parameter is inactivated. Its icon disappears from
BCL_HACMP window.
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Tracing hacmp.out

Step 1

Choose Trace Logs => hacmp.out => Enable Log Trace from BCL_HACMP application
menu.

Step 2

The HACMP_Out text parameter appears into BCL_HACMP window.
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Step 3

Double click on HACMP_Out to open a text window containing lines of more recent
hacmp.out HACMP log, updated dynamically as the file is filled.
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Stop tracing hacmp.out

Step 1

Choose Trace Logs => hacmp.out => Disable Log Trace from BCL_HACMP application
menu.

Step 2

The HACMP_Out text parameter is inactivated. Its icon disappears from BCL_HACMP
window.
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Maintenance Mode
The following steps describes how to activate/desactivate maintenance mode.

Activating Maintenance Mode

Step 1

Choose Maintenance Mode => Enable Maintenance Mode from BCL_HACMP application
menu.
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Step 2

The confirmation dialog box appears. Press Accept button to enable maintenance mode.

Step 3

The next window indicates the result of operation.

If the maintenance mode has been set correctly the following window appears.

Wait for the new application discovery phase for applying modifications.
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Otherwise, a window indicating error appears.

Step 4

The acknowledgement dialog box appears.

Step 5

Maintenance Mode is now activated.

All alarms for cluster will be refreshed to match maintenance mode specifications, see page
5-6 according to the poll time of each application.
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Deactivating Maintenance Mode

Step 1

Choose Maintenance Mode => Disable Maintenance Mode from BCL_HACMP application
menu.

Step 2

Maintenance Mode is now deactivated.

All alarms for cluster will be refreshed to display warnings and alarms disabled by
maintenance mode specifications, see page 5-6 according to the poll time of each
application.
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Monitoring Functions
The following functionalities allow you to customize HACMP Cluster Management KM
display, by specifying instances not to display.

There are three ways to set these limitations:

• Stop monitoring a specific item

• Limiting the number of application instances

• Using a pattern indicating application instances names not to monitor

Note: All monitoring functionalities are only available through a PATROL development
console.

If you try to change configuration using a PATROL operator console, you will get the
window:

Stop Monitoring
Stop monitoring menu is a general menu, applicable to all applications, except:

• BCL_CLUSTER

• BCL_COLLECT

• BCL_HACMP

All other KM applications use this menu. For the convenience of users, we will only indicate,
as an example, how to stop monitoring a BCL_ADAPTER instance.

Steps are indentical for other applications.

Step 1

Choose Stop Monitoring from appropriate application menu (in the example:
BCL_ADAPTER application menu).
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Step 2

A confirmation window appears. Press the Accept button to process new configuration.

Step 3

The result of your configuration is displayed in an acknowledgement window.

If configuration propagation is unsuccessful for BCL_CLUSTER application dependances,
an error window is displayed, with the reason of the failure. It is necessary, in this case, to
correct the problem, and to change HACMP Cluster Management KM configuration
manually on all nodes where configuration is not set.

In this example, for example, configuration for node “jean” has not been modified.

It will be necessary to change the value of BCL_ADAPTER_Pattern variable into the
BCL_conf file (KM configuration file) on the cluster node: see Customize HACMP Cluster
Management KM to have a description of each usable variable.

By editing it, and adding the string “|jean_boot” (new value choosen) to the old value, the
KM will take this new value into account in next application discovery phase.

If the specified variable is not set, add the line to the configuration file :

BCL_ADAPTER_Pattern=“jean_boot”
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Otherwise, the selected instance icon disappears from the parent application window: see
application hierarchy, on page 2-5 (in the example: BCL_NETWORK window).

If not already activated, new parameters appear:

– <parent application prefix>_<application type>NotMonitored: text parameter indicating
appropriate application instances disabled for monitoring by the user (in the example:
NET_AdapterNotMonitored parameter).

– <parent application prefix>_Max<application type>: stoplight parameter indicating a
warning if any appropriate application instance is not monitored (in the example:
NET_MaxAdapter parameter). Its value corresponds to the number of instances not
monitored for this application.

These parameters are inactivated if all instances of an application are monitored by the KM.

In order to enable an instance to be displayed again:

When an instance has stopped monitoring, its name is added to the pattern for instances
not to be monitored.

You can restart monitoring of instances that have been stopped by changing this pattern:
refer to Set a Pattern of unmonitored Instances section for more details.

In our example, adapter “jean_boot” has been stopped monitoring. The pattern for the
instances not to monitored is similar to: “...|jean_boot”. Removing “|jean_boot” string in
pattern and make sure that the regular expression does not match this string, will have the
effect that the KM will reintegrate “jean_boot” adapter in the instances to monitored.
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Set Maximum Number of Instances to Monitor
This function allows you to limit a given application instances number to a user fixed value.

It can be used for any application except BCL_CLUSTER, BCL_COLLECT and
BCL_HACMP.

To illustrate this functionality, we will limit the number of monitored adapters to 3 instances
by configuring BCL_ADAPTER application.

Step 1

Choose Configure Monitored Items => appropriate application type => Set Maximum
Number Monitored from BCL_CLUSTER or BCL_HACMP application menu, whichever
application is the parent of the selected application instance.

Note: Configuration of maximum number from BCL_CLUSTER application menu is
automatically propagated to all cluster nodes, in order to be taken in account by any
potential new primary node.

Step 2

From the next window, enter the new maximum number of instances to monitor. Press the
Accept button to register this configuration.
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Step 3

The result of your configuration is displayed in an acknowledgement window.

If configuration propagation is unsuccessful for BCL_CLUSTER application dependances,
an error window is displayed, with the reason for the failure. It is necessary, in this case, to
correct the problem, and to change HACMP Cluster Management KM configuration
manually on all nodes where configuration is not set.

In this example, for example, configuration for node “jean” has not been modified.

It will be necessary to change the value of BCL_ADAPTER_Max_Instances variable into the
BCL_conf file (KM configuration file) on the cluster node: see Customize HACMP Cluster
Management KM to have a description of each usable variable.

By editing it, and replacing the old value by 3 (new value choosen), the KM will take this
new value into account in next application discovery phase.

If the specified variable is not set, add a new line in the configuration file:

BCL_ADAPTER_Max_Instances=3

Otherwise, an acknowledgement for the configuration modification is displayed.
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Step 4

Wait for the new application discovery phase, to allow the KM to take the new configuration
into account .

Instance icons disappears from the parent application window: see application hierarchy, on
page 2-5 (in the example: BCL_NETWORK window), until there are only the specified
maximum number.

If not already activated, new parameters appear:

– <parent application prefix>_<application type>NotMonitored: text parameter indicating
appropriate application instances disabled for monitoring by the user (in the example:
NET_AdapterNotMonitored parameter).

– <parent application prefix>_Max<application type>: stoplight parameter indicating a
warning if any appropriate application instance is not monitored (in the example:
NET_MaxAdapter parameter). Its value corresponds to the number of instances not
monitored for this application.

In order to enable any number of instances to display:

Use the same steps as above to change maximum number of a given application instances
to 0 (default value).
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Set a Pattern of unmonitored Instances
This function allows you to disable monitoring of a given application instances by providing a
pattern of instance names not to display.

This pattern is a regular expression using the same syntax than for the grep PSL command.
See PATROL Script Language Reference Manual for more details.

It can be used for any application except BCL_CLUSTER, BCL_COLLECT and
BCL_HACMP.

To illustrate this functionality, we will prevent all boot and stanby adapters to be monitored
by configuring BCL_ADAPTER application. In our example, these adapters are

Step 1

Choose Configure Monitored Items => appropriate application type => Set Pattern not
Monitored from BCL_CLUSTER or BCL_HACMP application menu, whichever application is
the parent of the selected application instance.

Note: Configuration of patterns from BCL_CLUSTER application menu is automatically
propagated to all cluster nodes, in order to be taken into account by any potential
new primary node.
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Step 2

From the next window, enter the new pattern of instances not to monitor. Press the Accept
button to register this configuration.

Step 3

The result of your configuration is displayed in an acknowledgement window.

If configuration propagation is unsuccessful for BCL_CLUSTER application dependances,
an error window is displayed, with the reason of the failure. It is necessary, in this case, to
correct the problem, and to change HACMP Cluster Management KM configuration
manually on all nodes where configuration is not set.

In this example, for example, configuration for node “jean” has not been modified.

It will be necessary to change the value of BCL_ADAPTER_Pattern variable in the
BCL_conf file (KM configuration file) on the cluster node: see Customize HACMP Cluster
Management KM to have a description of each usable variable.

By editing it, and replacing the old value by “.*_boot|.*_stby” (new value choosen), the KM
will take this new value into account in next application discovery phase.

If the specified variable is not set, add to configuration file the line:

BCL_ADAPTER_Pattern=“.*_boot|.*_stby”
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Otherwise, an acknowledgement for the configuration modification is displayed.

Step 4

Wait for the new application discovery phase, to allow the KM to take the new configuration
into account.

Instance icons disappears from parent application window: see application hierarchy, on
page 2-5 (in the example: BCL_NETWORK window), until there are only the specified
maximum number.

If not already activated, new parameters appear:

– <parent application prefix>_<application type>NotMonitored: text parameter indicating
appropriate application instances disabled for monitoring by the user (in the example:
NET_AdapterNotMonitored parameter).

– <parent application prefix>_Max<application type>: stoplight parameter indicating a
warning if any appropriate application instance is not monitored (in the example:
NET_MaxAdapter parameter). Its value corresponds to the number of instances not
monitored for this application.
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In order to clear pattern of instances not to display:

Use the same steps as above to change pattern of given application instances to an empty
string: ““ (default value).
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Primary Node
Following steps indicate how to set the primary node manually.

For more details about primary node, refer to Primary Node paragraph, on page 5-5.

Note: Primary node functionality is only available through a PATROL development console.

If you try to change configuration using a PATROL operator console, you will get the
window:

Step 1

Choose Set Primary Node from BCL_HACMP application menu.
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Step 2

In next window choose the node to be set for primary node.

Note: If no node is selected, the default value is set and election among all nodes restarts
as normal.

Step 3

The next window indicates the result of operation.

If a new primary node has been set correctly the following window appears.

Wait for the new application discovery phase for applying modifications.
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Otherwise, a window indicating error appears.
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Configure Remote Accesses
The following steps indicate how to automatically configure remote accesses for nodes, in
order to allow exchanges between cluster nodes for retrieveing cluster state.

Step 1

Choose Remote Users Configuration from BCL_HACMP application menu.

Step 2

Press the Configure button from the next window to automatically update .rhosts file

belonging to PATROL user used in this window.
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Step 3

The next window indicates the result of the operation.

If the configuration has been successfully updated, you get this window.

Otherwise, the reason of failure is indicated.
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Refreshing information
All HACMP Cluster Management KM information is collected by its collector parameters,
which are owned by the BCL_COLLECT application and updated according to their proper
poll time.

The following functionalities allow you to update information collected by the KM at any
moment, by forcing application discoveries and collector parameters refresh. There are four
levels of refresh commands:

• ALL: forces discovery of all applications and refreshes all collector parameters. This is
the most complete refresh.

• HACMP configuration: forces refresh of all information about HACMP configuration.

• Local Resources: forces refresh of any information attached to a node. This concerns
HACMP application, the events, the resources, the volume groups, the application
servers, the filesystems and the physical volumes.

• Network Information: forces refresh of any information attached to the cluster. This
concerns the cluster, the resource groups, the nodes, the networks and the adapters.

Note: This command is useful to retrieve information that has been modified and not
refreshed by the KM or if you want to retrieve the exact state of the cluster without
waiting for an asynchronous refresh of collector parameters.

Refreshing All Information
The following steps indicate how to update all the information contained by the HACMP
Cluster Management KM. This causes a forced discovery phase for each KM application,
and a forced update of all collector parameters.

Step 1

Choose Refresh => ALL from BCL_COLLECT application menu.

Step 2

A task window in BCL_HACMP application window, with a timer, indicates state and time
elapsed for the operation.
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If you open the associated window by double clicking on icon, you get:

During uptime, collector parameters are refreshed. You can see the collector update status
for each parameter in BCL_COLLECT application window.
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Step 3

When the task has been completed, you can destroy it or repeat it by clicking right on the
icon and choosing the appropriate command in popup menu.

The completed task is symbolized by the icon:

The window containing collector parameters looks like:
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Refreshing HACMP configuration information

Step 1

Choose Refresh => HACMP Configuration from BCL_COLLECT application menu.

Following Steps

Follow the steps for “Refreshing all information” paragraph above, from step 2.
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Refreshing local resources information

Step 1

Choose Refresh => Local Resources from BCL_COLLECT application menu.

Following Steps

Follow the steps for “Refreshing all information” paragraph above, from step 2.

Refreshing network information

Step 1

Choose Refresh => Network Informations from BCL_COLLECT application menu.

Following Steps

Follow the steps for “Refreshing all information” paragraph above, from step 2.
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Display KM Log
The following steps explain how to display the HACMP Cluster Management KM log.

Step 1

Choose Display KM Log from BCL_COLLECT application menu.

Step 2

From the next window, indicate the number of latest lines in this file you want to display
(default is the whole file).

Optionally, you can indicate a keyword to search in lines and/or a keyword to avoid.

When user choices are defined, press the Accept button.

Note: Pay attention to the number of lines to display. Result windows are limited by a
buffer, whose size is 500Kb by default. Limit the number of lines to display or change
the buffer size in main PATROL console options.
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Step 3

The command output window appears.

Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in BCL_HACMP window.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.
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Tracing KM Log
The following steps explain how to get the dynamic update of HACMP Cluster Management
KM log.

This allows you to follow KM activity and to track potential problems.

Step 1

Choose Trace KM Log => Enable Log Trace from BCL_COLLECT application menu.

Step 2

The COLL_KMLog text parameter appears in BCL_COLLECT window.
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Step 3

Double click on COLL_KMLog to open a text window containing the lines of BCL_log KM
log, updated dynamically as the file is filled.
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Stop tracing KM Log

Step 1

Choose Trace KM Log => Disable Log Trace from BCL_COLLECT application menu.

Step 2

The COLL_KMLog text parameter is inactivated. Its icon disappears from the
BCL_COLLECT window.



6-47Using the HACMP Cluster Management KM for PATROL

Debugging Mode
To follow the HACMP Cluster Management KM activity, a log file stores all modifications
about KM objects. In this KM, there are two levels of debug, that provides you two levels of
detail about KM and PATROL activities:

• Normal debug mode provides information about the main change into KM objects status.

• Verbose debug mode informs about any change, variable settings and application
discoveries in the KM.

By default, debugging mode is set to “Normal” mode.

For more information about debugging mode, see “Debugging Mode”,on page 5-8.

Changing debugging mode to Normal mode

Step 1

Choose Set KM Debug => Normal from BCL_COLLECT application menu.

Step 2

If debugging mode was previously set to “Verbose” mode, you will stop seeing debug lines
displayed in System Ouput of your cluster node.

The KM log file will now only be updated by main KM changes messages.

Note: Debugging mode level is displayed into BCL_HACMP infobox.
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Changing debugging mode to Verbose mode

Step 1

Choose Set KM Debug => Normal from BCL_COLLECT application menu.

Step 2

If debugging mode was previously set to “Normal” mode, you will see debug lines displayed
in the System Ouput window of your cluster node.

The KM log file will now be updated with all KM messages.

Note: Debugging mode level is displayed in the BCL_HACMP infobox.

Note: According to its specifications, this mode rapidly increases the KM log file size. Set
by default to 100 Kbytes, it is recommended to increase the size of this file, not to
have COLL_LogWarning parameter changed to warning state. See “Changing
HACMP Cluster Management KM log size” to get more information.

Note: It is possible to keep “Verbose” debugging mode, without displaying debug
messages in the System Output window of your cluster node:

Type in System Output window after prompt:

       %PSL set(“/BCL_HACMP/hacmp_debug”,0);

To restart display, rerun the steps for “Changing debugging mode to Verbose mode”
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Changing HACMP Cluster Management KM log size
The HACMP Cluster Management KM log file records permanently changes about KM
objects.

Set by default to 100 Kbytes, the log file maximum size prevents saturation of filesystems.
When the maximum size is reached, KM is saved into a “.bak” file and a warning appears,
triggeredby COLL_LogWarning parameter.

It is possible to change the KM log size directly by an application command: the following
steps indicate how to do this.

Step 1

Choose Set KM Log Size from the BCL_COLLECT application menu.

Step 2

From the next window, choose the new maximum log size and press the Accept button.
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Step 3

You can retrieve maximum KM log size in BCL_COLLECT infobox.
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Verifying Cluster Topology
The following steps show how to verify cluster topology, resources and custom defined
verification methods.

Step 1

Choose Verify Cluster from BCL_CLUSTER application menu.

Step 2

The login and password dialog box appears.
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Step 3

The command output window appears and is dynamically updated as the verify command is
running.

Step 4

Use File => Exit menu from the command output window to close it.

A report is generated and available in the BCL_HACMP window.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.
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Event Monitoring
HACMP Cluster Management KM monitors the HACMP defined events. Thus, when the
application detects an error, it change the state of the event. The KM retrieves these states
continuously and is an effective means to inform you that there is a problem.

The following functionalities allow you to get details of events and to manage them.

Retrieving last occurence of an event in hacmp.out HACMP log
The following steps show how to get the last lines of an event logged in the hacmp.out
HACMP file. If there are no line for this event in the last hacmp.out file, it skips to the next
most recent file until retrieving information.

Step 1

Choose Last line for this event from the BCL_EVENT application menu.

Step 2

The command output window appears.
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Step 3

Use File => Exit menu from the command output window to close it.

A report is generated and available in the BCL_EVENT window.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.

Retrieving all occurences of an event in hacmp.out HACMP log
The following steps show how to get all lines for a given event logged in the hacmp.out
HACMP file. If there are no line for this event in the last hacmp.out file, it skips to next most
recent file until retrieving information.

Step 1

Choose All lines for this event from BCL_EVENT application menu.
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Step 2

The command output window appears.

Step 3

Use File => Exit menu from the command output window to close it.

A report is generated and available in the BCL_EVENT window.

You can destroy it by clicking on this icon with the right mouse button and selecting Destroy
menu.
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Stop alarm on an event
In some cases, even after correcting the problem and restarting HACMP, events still indicate
an alarm corresponding to the last problem.

Especially for “config_too_long” event, correction of the problem is not sufficient to change
the state of event, since it starts when an HACMP phase is too long and does not stop after
event has been completed, if an error has occured, because it is not restarted anyway.

For this situation, the Reset Alarm menu command provides a method to manage event
alarms manually.

However, communication between HACMP administrator who will correct manually the
problem, if any, and PATROL administrator must be clear. This function must not be used if
there still is an unsolved problem, and in most cases, restarting HACMP from script failures
updates events status is sufficient, so event management is not necessary.

For an example, just after having installed the HACMP Cluster Management on my cluster,
an alarm indicates that the “config_too_long” event is running. Using the last lines for this
event menu command, it is easy to understand that this alarm has occured several days
previously and is no longer applicable. Verifying this fact with the HACMP administrator, I
can use the Reset Alarm menu command to cancel it.

Step 1

Choose Reset Alarm from BCL_EVENT application menu.
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Step 2

A login and password dialog box appears.

Step 3

The parameters assigned to the event are set to the non–alarm value.

Note: This configuration for events is stored in the $PATROL_HOME/remote/
BCL_shared_info/events.lst file to be taken into account for next sessions.
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Localizing Local Resources problems in cluster
The NODE_LocalResources parameter indicate status, in a general view, of all resources
depending on the local node. This is the worst state of all KM objects depending on the
BCL_HACMP application (BCL_APPLICATIONSERVER, BCL_EVENT, BCL_FILESYSTEM,
BCL_PHYSICALVOLUME, BCL_RESOURCEGROUP, BCL_VOLUMEGROUP).

For retrieving what instance(s) is(are) in a warning or in a alarm state without opening the
cluster node window, the following steps indicate an easy manner to get them.

In our example, “config_too_long” event is in alarm state. Some time later the event is in this
state, the cluster instance in main PATROL window indicates an alarm.  Opening cluster
window, we get:

Step 1

Choose Show Local Resources Problems from BCL_NODE application menu.
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Step 2

A command output window shows the warning and alarms instances that are responsable
for the node state.

Step 3

We learn that “config_too_long” event (from BCL_EVENT application), is in alarm state.

We can now take measures to correct this problem...

Use File => Exit menu from the command output window to close it.

A report is generated and available in the BCL_CLUSTER window.

You can destroy it by clicking on this icon with the right mouse button and selecting the
Destroy menu.
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Chapter 7. Event Messages

How to retrieve messages in the HACMP Cluster Management KM log ?
The HACMP Cluster Management KM log is a file that summarizes all KM activity by
collecting messages from all KM applications.

If you are connected on a node where the HACMP Cluster Management KM for PATROL is
installed and configured, you can look at this file to retrieve information, directly.

There are also different menu commands from the BCL_COLLECT application that allows
you to activate trace on this file, deactivate it and search information through it.

CAUTION:
The messages stored in the HACMP Cluster Management KM log depend on the
debugging mode used. Using the ”normal” debugging mode.

To activate trace on the HACMP Cluster Management KM log:
Use the Trace KM Log => Enable KM Log Trace menu command from the BCL_COLLECT
application: this activates the COLL_KMLog parameter which shows you dynamically the
latest lines logged in the file.

Double click on the BCL_COLLECT application instance to reach the COLL_KMLog
parameter.

Double click on the COLL_KMLog parameter to obtain the trace.

To deactivate trace on the HACMP Cluster Management KM log:
Use the Trace KM Log => Disable KM Log Trace menu command from the BCL_COLLECT
application: this deactivates the COLL_KMLog parameter which shows you dynamically the
latest lines logged into the file.

To search information into the HACMP Cluster Management KM log:
Use the Display KM Log menu command from the BCL_COLLECT application: this
activates the COLL_KMLog parameter which shows you dynamically the latest lines logged
into the file.

Enter information to retrieve as described in the menu command summary.

To set debugging mode to ”normal”:
Use the Set KM Debug => Normal Mode menu command from the BCL_COLLECT
application.

To set debugging mode to ”verbose”:
Use the Set KM Debug => Verbose Mode menu command from the BCL_COLLECT
application.

How to retrieve messages in the PATROL Event Manager ?
All messages in the HACMP Cluster Management KM for PATROL are stored in the
PATROL Event Manager event repository.

To use PATROL Event Manager, refer to the User Guide for your console (Unix or Windows
NT).
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The HACMP Cluster Management KM events come from the BCL_HACMP event catalog.
They shared different features:

• They have the same origin: BCL_HACMP. So you can use a filter with this origin to
retrieve all events stored from HACMP Cluster Management KM for PATROL.

• They have the same owner: Bull.

• None of them have an escalation command or notification command or an acknowledge
command: it is the responsibility of the PATROL administrator to set the appropriate
commands to his needs.

• All of them have expert advice, that can be used for alarm events.

You can retrieve below the description of all the HACMP Cluster Management KM events:

Event Name Description

AdapDown Indicates changes in BCL_ADAPTER instances status

CollectorStatus Indicates refreshes in BCL_COLLECT parameters

DeletedItem Indicates application instances that have been destroyed

DiskError Indicates changes in BCL_PHYSICALVOLUME instances status

EventError Indicates changes in BCL_EVENT instances status

HACMPStatus Indicates changes in BCL_HACMP instance status

NewItem Indicates application instances newly created

NodeError Indicates changes in BCL_NODE instances status

ResGroupError Indicates changes in BCL_RESOURCEGROUP instances status

ResourcesError Indicates changes in BCL_RESOURCES instances status

UpdStatus Indicates changes in application instances status

WaitStatus Indicates wait time for creation of new application instances

Using the appropriate filters, you can retrieve easily information you need and stored history
of your cluster.

Examples of  alarms retrieved using PATROL Event Manager:
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Examples of warnings retrieved using PATROL Event Manager:

List of Messages

Creating instance instance in state state parent: parent_instance
This message indicates that the creation of the application instance instance is successful.
This new instance has been generated in state state and has parent_instance as direct
parent.

Cannot create instance instance in state state parent: parent_instance
This message indicates that the creation of the application instance instance has failed. This
instance would have state state and would have parent_instance as direct parent.

Cause:

This is usually caused by:

A memory problem has prevented the creation of the application instance.

Remedy:

If the problem persists, call your system administrator to verify memory usage.

Destroying instance instance
This message indicates that the deletion of the application instance instance is successful.

Cannot destroy instance instance
This message indicates that the deletion of the application instance instance has failed.

Cause:

This is usually caused by:

A memory problem has prevented the creation of the application instance.

Remedy:

If the problem persists, call your system administrator to verify memory usage.

instance waiting for: variable
To create application instances, the collector parameters collect all information about your
HACMP configuration and status. This creation cannot be complete unless all information is
collected.

This is why, during discovery phase of applications, this message appears.

This message indicates that the creation of the application instance instance is delayed.
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After 100 unsuccessful attempts, an event is generated to trace the problem.

Cause:

This is usually caused by:

• An incomplete gathering of information by the collector parameters.

• During start of PATROL Agent, it is usual to get this message. Wait several minutes to
allow the KM ro retrieve all information mandatory for the creation of instances.

Remedy:

• Wait for an update of all collector parameters.

• Wait for the creation of application instances.

• If the problem persists, use the Refresh => ALL menu command from the
BCL_COLLECT application.

• If you get this message again, call customer support.

instance1 waiting for creation of instance: instance2
According to the hierarchical architecture of the HACMP Cluster Management KM for
PATROL, some application instances depend on the creation of other application instances.

This message indicates that the creation of the application instance instance1 is delayed.

After 100 unsuccessful attempts, an event is generated to trace the problem.

Cause:

This is usually caused by:

• A asynchronous discovery of all application instances included in HACMP Cluster
Management KM for PATROL.

• An incomplete gathering of information by the collector parameters.

• During start of PATROL Agent, it is usual to get this message. Wait several minutes to
allow the KM to retrieve all information mandatory for the creation of instances.

Remedy:

• Wait for an update of all collector parameters.

• Wait for the creation of application instances.

• If the problem persists, use the Refresh => ALL menu command from the
BCL_COLLECT application.

• If you get this message again, call customer support.

Changing State of instance from state state1 to state2

Reason: message
This message indicates that the status change of the application instance instance from
state1 to state2 is successful.

A message provides the reason why the status has changed (not mandatory).

Alarms not allowed in maintenance mode
or

Alarms for service adapter disabled in maintenance mode
or
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Warnings for standby adapter disabled in maintenance mode
or

Node node disabled for alarms in maintenance mode
or

Node node disabled for alarms in maintenance mode
This message indicates that the status change of the application instance generating this
message is treated not to generate a warning or alarm status for the instance because the
maintenance mode has been activated.

IP adress for Adapter adapter unreachable
or

Communication with standby adapter impossible
or

Communication with service adapter impossible
or

Communication with boot adapter impossible
or

Service Adapter not in available State...
or

Node node unreachable
This message indicates that the adapter instance generating this message is not reponding
or the node node is not responding.

Cannot retrieve console information on node node
or

Cannot retrieve Local Resources on node node
This message indicates that the remote node node cannot transfer information about its
state.

Cause:

This is usually caused by:

• The node node is not responding.

• Access rights for shared information ($PATROL_HOME/remote/BCL_shared_info
directory) are not set for the PATROL user on node generating this message to node.

Remedy:

• Verify communication with remote node

• Verify access rights for PATROL user on node generating this message to node.

• Use Remote Users Configuration menu command to update access rights between the
both nodes.
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Primary Node elected: node
This message indicates that election of primary node has resulted in the node node
election.

Cannot retrieve information from physical volume: command
bclwapi_pv...

This message indicates that the command retrieving information about physical volume has
failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_pv command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No physical volume and no volume group are defined in your HACMP configuration of the
node.

Remedy:

• Verify your HACMP configuration for retrieving volume group or physical volume
information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Cannot retrieve information from system errlog
This message indicates that the system command ”errpt” has failed.

Cause:

This is usually caused by:

• Access rights to $PATROL_HOME/remote/BCL_shared_info directory are not set for
PATROL user

• The system error log file (/var/adm/ras/errlog) has corrupted

• The access rights for the ”errpt” command have been refused to the PATROL user

Remedy:

• Verify access rights for $PATROL_HOME/remote/BCL_shared_info directory

• Contact your administrator to correct this problem

Infos from events not available...
This message indicates that the command retrieving information about events
($PATROL_HOME/BCL_KM/bin/bclwapi_lastevent) has failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_lastevent command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

Remedy:

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.
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Infos from cluster not available...
This message indicates that the command retrieving general information about cluster
configuration has failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_info command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No cluster is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving cluster information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos from nodes configuration not available...
This message indicates that the command retrieving general information about nodes has
failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_node command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No node is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving node information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos from resource groups not available...
This message indicates that the command retrieving general information about resource
groups has failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_listrsc command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No resource group is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving resource group information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.
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Infos from application servers not available...
This message indicates that the command retrieving general information about application
servers has failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_listrsc command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No application server is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving application server information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos for resource groups not available...
This message indicates that the command retrieving information about a given resource
group has failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/cllsres command have changed.
user change or AIX PTFs updating HACMP release.

• No resource group is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving resource group information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Cannot retrieve information from physical volume: command
bclwapi_fs...

This message indicates that the command retrieving information about file systems has
failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_fs command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No file system are defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving file systems information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.
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Cannot retrieve information from physical volume: command
bclwapi_svg...

This message indicates that the command retrieving information about volume groups has
failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_svg command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

• No volume group and no file system are defined in your HACMP configuration of the
node.

Remedy:

• Verify your HACMP configuration for retrieving volume group of file system information on
the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos for adapters not available...
This message indicates that the command retrieving information about adapters has failed
or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_addr command (or
HACMP commands used by this script) command have changed: user change or AIX
PTFs updating HACMP release.

• No adapter is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving adapter information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos for networks not available...
This message indicates that the command retrieving information about networks has failed
or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_netstate command (or
HACMP commands used by this script) command have changed: user change or AIX
PTFs updating HACMP release.

• No network is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving network information on the node

• Synchronize HACMP configuration if not done
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• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Infos from resource groups not available: command clfindres fails or
no resource group defined...

This message indicates that the command retrieving information about resource groups has
failed or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/clfindres command have
changed: user change or AIX PTFs updating HACMP release.

• No resource group is defined in your HACMP configuration of the node.

Remedy:

• Verify your HACMP configuration for retrieving resource group information on the node

• Synchronize HACMP configuration if not done

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Cannot retrieve information from processes
This message indicates that the command retrieving information about processes has failed
or does not return anything.

Cause:

This is usually caused by:

• The access rights of the $PATROL_HOME/BCL_KM/bin/bclwapi_ps command (or
HACMP commands used by this script) have changed: user change or AIX PTFs
updating HACMP release.

Remedy:

• Rerun configuration script $PATROL_HOME/BCL_KM/config/BCL_config if access rights
are not correctly set.

Collecting collector parameter
This message indicates that collector parameter collector is starting to collect information for
HACMP Cluster Management KM

Event event has problem.
This message indicates that the command retrieving information about events has detected
a problem on HACMP event event.

Remedy:

• Use Last lines for this event menu command from BCL_EVENT application instance
event

• Search in the text window for the reason

• If the problem is solved manually and the event is still in the alarm state, use the Reset
Alarm menu command from BCL_EVENT application instance event

Clstrmgr process or topsvcs not active
or
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HACMP processes not available on node
This message indicates that HACMP services are not active on node.

Cause:

This is usually caused by:

• A stop of the HACMP application has been planned (maintenance of system,...)

• The node has been stopped

Remedy:

• Verify with your administrator if this stop has been planned

• If this stop has been planned, you may use the maintenance mode to avoid alarms: use
the Maintenance Mode => Enable Maintenance Mode menu command from the
BCL_HACMP application

• Otherwise, verify if the node is not restarting HACMP on the node

• If not, alert your administrator or this unexpected stop in order to restart it as soon as
possible

Patrol Agent unreachable on node
This message indicates that HACMP services are not active on node.

Cause:

This is usually caused by:

• PatrolAgent process has been stopped or killed on node node

• Communication with node node is impossible

Remedy:

• Verify communication with node node

• If communication is OK, verify the presence of PatrolAgent process using the command:
”ps –ef|grep PatrolAgent”

• Restart this process on this node: refer to the User Guide of your console (Unix or
Windows NT)

Local Resources on node node in WARNING state
This message indicates that at least one resource of node node is in warning state.

Remedy:

• Use Show Local Resources Problems menu command from the BCL_NODE application
instance node

• Open the node system window to retrieve warning on PATROL object indicated by the
result of the command above.

• See parameters value to identify warning or use PATROL Event Manager to retrieve
warning message about this PATROL object

Local Resources on node node in ALARM state
This message indicates that at least one resource of node node is in alarm state.

Remedy:

• Use Show Local Resources Problems menu command from the BCL_NODE application
instance node

• Open the node system window to retrieve alarm on PATROL object indicated by the
result of the command above.
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• See parameters value to identify alarm or use PATROL Event Manager to retrieve alarm
message about this PATROL object

Permanent error on disk disk
This message indicates that the COLL_Disk collector parameter has detected a permanent
error in system errlog on disk disk.

Cause:

This is usually caused by:

• AIX has detected a permanent problem on disk disk

Remedy:

• You can get more detail on system errlog error message by using the Display Logs =>
System Errlog menu command from the BCL_HACMP application.

• Contact your administrator to solve this problem.

Temporary error on disk disk
This message indicates that the COLL_Disk collector parameter has detected a temporary
error in system errlog on disk disk. This means that the error has been corrected, but similar
multiple errors on the same disk could hide a real problem.

Cause:

This is usually caused by:

• AIX has detected a temporary problem on disk disk

Remedy:

• You can get more detail on system errlog error message by using the Display Logs =>
System Errlog menu command from the BCL_HACMP application.

• Contact your administrator to solve this problem, if the same error is repeted regularly on
the same disk.

Disk disk no more in active state...
This message indicates that the disk disk, previously in available state is now defined.

Resource Group resource group not running on its sticky location
or

Concurrent Resource Group resource group not running on all its
original nodes

or

Cascading Resource Group resource group not running on its original
node

This message indicates that the resource group resource group is not actually running  on
its normal location:

• Concurrent resource groups should run on all the nodes belonging to the participating
node list of the resource group

• Cascading resource group without sticky location should run on the first node of its
participating node list

• Cascading resource group with sticky location should run on the node corresponding to
the sticky location
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An Error has been detected in Resource Group resource group

Please check HACMP logs for correcting the problem
or

Resource Group resource group is currently running in instable state

If problem persists, check HACMP logs for looking about some errors
or

Error(s) detected in local resources resources

Please check HACMP logs for more informations
or

Local resources resources running in uncertain state

Please check HACMP logs for more informations
This message indicates that the COLL_Network collector parameter has detected a
potential error on resource group resource group.

Cause:

This is usually caused by:

• Resource group indicated is running in a state ACQUIRING, RELEASING or ERROR.
For these three states, infobox of the resource group indicates : ????.

Remedy:

• Wait several minutes to see if state of the resource group changes (it is possible that it is
stopping or starting).

• If the state does not change, search in hacmp.out HACMP log file for errors about this
resource group. You can use the Display Logs => Display hacmp.out menu command
from the BCL_HACMP application to see this file.
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Glossary

This glossary contains the abbreviations, keywords and phrases that can be found in this document.

Adapter (Network Adapter)
Connects a node to a network. Synonym: interface.
A node is typically configured with at least two
network interfaces for each network to which it
connects: a service interface that handles cluster
traffic, and one or more standby interfaces.

alarm
An indication that either a resource has returned a
value that falls within the alarm range or that the
application check cycle has discovered a missing
file or application since the last application check.
The alarm status of the object is indicated by the
object icon status, which will be red and flashing.

alarm state
An alarm state occurs when one or more computer
parameters are in an alarm state and/or an
application whose state is propagated is in an
alarm state.

ALL_COMPUTERS class
The highest object class level in PATROL.
Attributes assigned to this class will be inherited by
all computer classes known to PATROL.

application
A computer program or executable with its
associated files that can exist on a computer is
called an application. Examples of applications
include a database, a file system, and a
spreadsheet program. Any group of computer
programs and files is called an application class.

application check cycle
The period during which the process cache is
checked to ensure that all applications and files
previously discovered still exist there. See
application discovery.

application class
The name of the object class.

application discovery
A procedure carried out by the PATROL Agent
running on each managed computer at preset
intervals. The application description information is
checked against the information in a cache, which
is periodically updated. The cache contains
information about the system process table. 
Each time the cache is refreshed, application
discovery is triggered. Any new applications

discovered and state changes since the last refresh
are then sent to the Console.

application discovery rules (application
description)
A set of rules stored in PATROL Agent and
periodically evaluated to find out whether a specific
application class exists in the monitored
environment. They describe how PATROL Agent
can detect instances of this application on a
machine, what icon to draw, and so on. Two types
of application discovery exist: simple and PATROL
Script Language (PSL).

application instance
Each running copy of an application discovered by
PATROL. See instance.

Application Server
An application that runs on a cluster node. When
queried by client applications, the application
server may access a database on the shared
external disk and then respond to client requests.
Application servers are configured as cluster
resources that are made highly available with start
and stop scripts supplied by the user or application.

Boot Address
Address for a node to use before HACMP assigns
a service address. If you want to use IP address
takeover (with or without hardware address
swapping) in an HACMP cluster, you must define a
boot address (associated with a service adapter)
so when a failed node comes back up, it can use
the boot address until the process of node
reintegration reassigns IP addresses. 
This boot address can be used during
HACMP activity if you use the IP aliasing mode.

built–in command
Internal commands offered by PATROL Agent to
reset the state of an object, refresh parameters,
echo text, and so forth. See ”How to Use Built–In
Commands” in the PATROL Console Help.

built–in variables
Internal variables maintained by PATROL for use in
commands and parameters.

Cascading Resources
Resources that may be taken over by more than
one node. A takeover priority is assigned to each
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configured cluster resource group on a per–node
basis. In the event of a takeover, the node with the
highest priority acquires the resource group. If that
node is unavailable, the node with the next–highest
priority acquires the resource group, and so on.

class
The object classification in PATROL. It is used to
define a hierarchy for attribute inheritance. Objects
in PATROL can have one of the following classes:

• ALL_COMPUTERS

• Computer Class

• Computer Instance

• Application Class

• Application Instance

Attributes can be defined for each PATROL object
class and are inherited by any object at a lower
class level. The class classification is higher than
the instance classification.

Cluster
Loosely–coupled collection of independent systems
(nodes) organized into a network for the purpose of
sharing resources and communicating with each
other. HACMP defines relationships among
cooperating systems where peer cluster nodes
provide the services offered by a cluster node
should that node be unable to do so.

Cluster Information Program (Clinfo)
SNMP monitor program. Clinfo, running on a client
machine or on a cluster node, queries the
clsmuxpd daemon for updated cluster information.
If then makes information about the state of an
HACMP cluster, nodes, and networks available to
lients and applications running in a clustered
environment. Clinfo and its associated APIs enable
developers to write applications that recognize and
respond to changes within a cluster.

Cluster lock daemon (cllockd)
HACMP daemon responsible for coordinating
requests for shared data across the cluster. It
institutes a locking protocol that server processes
use to coordinate data access and to ensure data
consistency during normal operation as well as in
the event of failure.

Cluster Manager (clstrmgr)
HACMP daemon responsible for monitoring local
hardware and software subsystems, tracking the
state of cluster peers, and triggering cluster events
when there is a change in the status of the cluster.

Cluster Resource Manager (clresmgrd)
HACMP daemon responsible for centralizing the
storage of and publishing updated information
about HACMP–defined resource groups.The
Resource Manager on each node coordinates

information gathered from the HACMP global
ODM, the Cluster Manager and other Resource
Managers in the cluster to maintain updated
information about the content, location and status
of all HACMP resource groups.

Cluster SMUX Peer (clsmuxpd)
HACMP daemon that provides Simple Network
Management Protocol (SNMP) support to client
applications. It maintains cluster status information
in a special HACMP MIB. Developers can use one
of the Clinfo APIs or standard SNMP routines to
access the cluster information in this MIB.

collector parameter
A PATROL variable that contains instructions for
gathering values for consumer parameters to
display. A collector parameter does not display any
value, nor does a collector parameter issue alarms
or invoke recovery actions. See also parameter,
standard parameter, and consumer parameter.

command type
The language used for the command and
describes how the command is executed. PATROL
has two default command types: OS and PSL.

computer class
A computer class is the basic type of computer and
how it is represented on the Console. Examples
include the following:

• SUN

• HP–UX

• RS6000

computer instance
A computer instance is a computer with PATROL
Agent installed. It is represented on the Console
using the information about the computer class
stored in the system knowledge module.

computer screen
All output written to the computer can be viewed by
clicking on the computer icon screen (the icon
hot–spot). When new data is written to the
computer, the icon screen turns blue.

computer type
See computer class.

Concurrent Access
Simultaneous acces to a shared volume group or a
raw disk by two or more nodes. In this
configuration, all the nodes defined for concurrent
access to a shared volume group are owners of the
shared resources associated with the volume
group or raw disk. 
If one of the nodes in a concurrent access
environment fails, it releases the shared volume
group or disk, along with all its resources. Access
to the shared volume group or disk is, however,
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continuously available, as long as another node is
up. Applications can switch to another server
immediately.

configuration file
A file that gives the characteristics of system or
subsystem.

Console
The workspace from which you command and
manage the distributed environment monitored by
PATROL. The Console displays all the monitored
computers and applications as icons.
The Console interacts with the PATROL Agent on
each remote computer.The dialog is event–driven
so that messages reach the Console only when a
specific event causes a state change on the
monitored computer. 
You can run commands and tasks against
monitored computers from the Console. From the
Console, you can log in to a computer that is
displayed by using the computer pop–up menu.

consumer parameter
A PATROL variable that only displays a value that
was gathered by a collector parameter. A
consumer parameter does not include any
data–gathering instructions, including scheduling
information. See also parameter, standard
parameter, and collector parameter.

container
A representation of a logical or functional subset of
computers, applications, and parameters in a
distributed environment. 
A container can contain one or more container
icons. Once a container is defined, object hierarchy
applies at each level of container. That is, a
container icon found within a container icon
assumes the variable settings of the container in
which it displays.

Debugging Mode
The HACMP Cluster Management KM for PATROL
allows you to generate information about the KM
activity into the HACMP Cluster Management KM
log, and into the Sytem Output window. Two
different debugging mode are possible:

• ”Normal Mode”: logs information about
application instances creation, deletion and their
status changes. Some other messages are
generated to trace the consoles connected to
the nodes.

• ”Verbose Mode”: logs all information describes
above, plus KM variables affectations, collector
parameters updates, application discoveries
entrances, etc... 

To set debugging mode to ”normal”:

• use the Set KM Debug = Normal Mode menu
command from the BCL_COLLECT application 

To set debugging mode to ”verbose”:

• use the Set KM Debug = Verbose Mode menu
command from the BCL_COLLECT application

desensitized
Grayed out. When an icon appears this way, it
usually means that no connection is established to
the object or that the object is not active.

event
The occurrence of a state change in a monitored
object. Such objects include computers,
applications, or  parameter. Events are captured by
the PATROL Agent and stored in a repository file.
Events are forwarded by a PATROL Agent to all
PATROL Event Managers (PEMs) that are
connected to it. The types of events forwarded by
the Agent are governed by a Persistent Filter for
each PEM/PATROL Agent relationship.

Event (or Cluster Event)
Represents a change in a cluster’s composition
that the Cluster Manager recognizes and can
respond to. Major cluster events include: 

• node_down– a node detaches from the cluster

• node_up– a node joins or rejoins the cluster

• network_down– a network failure

• network_up– a network is added or restored

• swap_adapter– a service adapter fails

Event Diary
Part of the PATROL Event Manager (PEM), it is a
place to store your comments on any event in the
repository. It can be amended at any time and is
accessed through the Event Manager Details
window.

event escalation
The increase in the severity of an event as the
result of its persistence. An escalation action can
be triggered only by the PATROL Agent.

Event Repository
The PATROL Event Manager’s database of events.
Events are stored to provide a history of events
that you can use for problem resolution. 
The database is a circular file residing on an Agent
machine. It stores a limited number of events.
When the maximum number of events is reached
and a new event is stored, the oldest event is
removed in a cyclical fashion.
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file system
A set of files stored on a disk or on one partition of
a disk. A file system has one root directory that
contains files and subdirectories. These
subdirectories can in turn contain files and other
directories. In the KM for Unix, the FILESYSTEM
application monitors and provides information
about file system resources.

full discovery
During a full discovery, a PATROL Agent searches
the refreshed process cache for any new instances
of an application class. In contrast, in the
application check cycle, the PATROL Agent
searches only to see whether previously existing
applications are still running. A full discovery cycle
has little effect on applications using PATROL
Script Language (PSL) discovery rules. If needed,
however, PSL can use the full discovery PSL
built–in function. See simple discovery.

global level
A term used in PATROL to describe the
ALL_COMPUTERS class, computer class, and
application class object classification level.

global–level attribute
Attributes assigned to objects at class level rather
than at instance level. Global–level attributes are
defined once, then inherited by every object of that
class discovered in the PATROL environment. An
attribute assigned to a specific computer class,
SUN for example, will be inherited by every
instance of a SUN computer found running in the
distributed environment.

global parameter
A global parameter applies to an entire class of
object. Typically, a global parameter is active on
ALL instances of a particular application class or on
ALL computers of a certain computer class. See
parameter.

HACMP (High Availability Cluster
Multi–Processing) for AIX
Licensed Program Product (LPP) that provides
custom software that recognizes changes within a
cluster and coordinates the use of AIX features to
create a highly available environment for critical
data and applications.

history level
The amount of time that parameter values are
stored in the history database before they are
automatically purged. The level setting can be
either inherited or local. See inherited history and
local history.

icon
Indicates whether the parameter is represented as
a graph, gauge, or text.

icon type
The icon type for the object. PATROL has three
types of icons:

• application

• parameter

• computer

icon window
The icon window appears when you double–click
on an instance of an object icon or a container icon
with MB1 in Unix or the left mouse button in
Windows NT. The window displays icons for all the
objects associated with the object from which the
window was displayed.

InfoBox
A window that displays current summary
information for an object. It has both static fields
that display current values, such as current state
and icon type, and information fields that you can
create for the object yourself.

information event
Any event that is not a state change (warning or
alarm) or an error. Typical information events are
as follows:

• A parameter is either activated or deactivated.

• A global parameter is suspended or resumed.

• Application discovery is run.

The default setting for PATROL is to prevent this
type of event from being stored in the event
repository. To store and display this type of event,
you need to turn silent mode off for the computer
instance.

inherited history
The default history retention period for any
application parameters that is will be inherited from
a higher level object (for example, a computer
class or a Console preference setting).

instance
A representation of a computer, application,
parameter, or command that is running in the
PATROL–managed environment.

instance level
Each computer being monitored, or representation
of an application that is running, is an instance of
the class of computer or application. PATROL
Agent monitors computer or application instances.
To set attributes, variables, and commands at a
certain level, you use the pop–up menu for the
PATROL object shown. This is called the local
level. Settings at this level override settings at
higher class levels.
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Knowledge Module (KM)
A set of files from which a PATROL Agent receives
information about all the applications running on a
monitored system. Knowledge Modules can be
downloaded from a Developer Console or installed
using a utility on an Agent machine. 
The information used to discover and represent the
applications, the parameters it runs against those
applications, and the menu options available on
pop–up menus are all provided by Knowledge
Modules.

local history
Requires the user to set the default history
retention period for the application parameters.

local level
The individual instance of a computer, application,
parameter, or command.

local–level attribute
An attribute defined for objects at the object
instance level. Local–level attributes must be
defined for each instance of an object class
individually. These attributes override the attributes
assigned to the object class.

Log Files
Files that containn messages put out by the
HACMP for AIX subsystems (e.g., event
notification messages, verbose script output
messages, and cluster state messages). Log files
can provide valuable information for
troubleshooting cluster problems.

• The /usr adm/cluster.log file contains
time–stamped, formatted messages generated
by HACMP scripts and daemons.

• The /tmp/cm.log file contains time–stamped
formatted messages generated by
HACMP clstrmgr activity.

• The /tmp/hacmp.out file contains messages
generated by HACMP scripts; it does not contain
state messages.

• The system error log contains time stamped
formatted messages from all AIX subsystems
including HACMP scripts and daemons.

Logical Volume Manager (LVM)
AIX facility that manages disks at the logical level.
HACMP uses AIX LVM facilities to provide high
availability– in particular, volume groups and disk
mirroring.

Maintenance Mode
HACMP Cluster Management KM specificity:
allows you not to display alarms from a cluster if
service operations have been planned for a given
node, for example. 
In that case, alarms will no longer be treated for the
node in maintenance mode: node alarms and

adapter alarms. 
If the node is still reachable, HACMP Cluster
Management KM gives state of PatrolAgent, but
not the state of the local resources for the node
(parameters are deactivated, but events are still
generated and visible by Patrol Event Manager.) 
Adapters alarms are not treated: adapters turn in
OFFLINE state if not available.

Network
In HACMP environment, connects multiple nodes
and allows clients to access these nodes.
HACMP defines various types of networks.

new data state
New data commands are activated when data is
being written to the computer Console window.
Note: This menu is only accessible via the
computer application menu and is used by
PATROLINK. Refer to the PATROLINK Reference
manual for more information.

Node (or Cluster Node)
RS/6000 system unit that participates in an
HACMP cluster as a server.

object
A computer, application, parameter, or container in
the PATROL–managed environment.

object icons
Icons that represent a computer, application,
parameter, or container in the PATROL–managed
environment.

OK and Not OK icons
These icons show the user the state of a PATROL
object. See state.

OK state
An OK state occurs when there is a network
connection between the Console and the computer,
the PATROL Agent is running, all parameters are
OK, and all applications propagating their state are
OK.

offline state
An offline state occurs when one or more computer
parameters are offline and/or an application whose
state is propagated is offline.

OS command
An operating system command that is spawned by
PATROL and executes in the current PATROL
environment. It can be a short sequence of
commands or a large script. Unlike tasks, the user
cannot restart or stop the command before it has
been completed.

output range
Indicates when a warning and an alarm occur
based on the value set in the parameter.
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parameter
In PATROL, on item of knowledge about what to
check and how often. 
It can include

• a description of the monitored attribute

• how often to check the attribute

• the instructions for measuring and monitoring
the attribute

• detection thresholds for abnormal attribute
values

Parameter commands are stored by the PATROL
Agent and are periodically executed to retrieve
data about the managed computer or application.
Parameter information can be displayed as a
graph, a gauge, or in a text window. Parameters
add information to the built–in rules about
computers and applications and contain recovery
actions that are triggered when the parameter
detects an unhealthy state (that is, when a returned
value falls outside specified alarm ranges).

parameter type
A classification of PATROL parameters that identify
whether a parameter is a

• standard parameter

• consumer parameter

• collector parameter

PATROL Agent
A fundamental part of the PATROL architecture,
which is used for remote monitoring and
management of hosts. It can communicate with the
PATROL Console, the stand–alone PEM Console,
and PATROLVIEW. It is configured by the PATROL
Agent Configuration utility and is used to analyze
the managed computer and to communicate with a
console and Event Manager.

PATROL Console
The graphical Console. It is the display
environment responsible for receiving rules and
commands from the user and sending them to the
PATROL Agent and receiving information from the
agent. It displays a real–time picture of the status
of all the computers being managed and
applications discovered from information it receives
from the PATROL Agent. 
From the PATROL Console, you can monitor and
manage either an entire enterprise–wide
information system or just a collection of
workstations and server computers. PATROL offers
two types of SNMP consoles with different levels of
functionality, a PATROL Developer Console and a
PATROL Operator Console.

PATROL Developer Console
An interface to PATROL that administrators can

use to monitor and manage applications and to
customize and create Knowledge Modules.

PATROL Event Manager
A facility that provides a selective view of events
occurring on your system resources. It can be
accessed from the Console or used as a
stand–alone facility in large–scale installations. It
works with the PATROL Agent and user–specified
filters to provide a view of only the most important
events.

PATROL Event Manager Console
A stand–alone application used to manage PEM
window connections to one or more hosts running
PATROL Agents.

PATROLINK
An integration package used to link PATROL with
network management and other external
applications.

PATROL Applications Manager Console
An interface to PATROL that operators can use to
manage applications but without being able to
customize or create Knowledge Modules,
commands, and so forth.

PATROL Script Language (PSL)
A programming language for writing sophisticated
application discovery procedures and parameters.
PSL is an interpreted language for use within the
PATROL environment. It can also be used to write
arbitrary commands and tasks.

PATROLVIEW
A product that provides the ability to view events
and monitor and display all the parameters
provided by the PATROL Agents and Knowledge
Modules.

persistent filter
A filter used to determine which events will be
forwarded from a PATROL Agent to a specific
PATROL Event Manager (PEM). This capability
helps minimize network traffic. PATROL Agents
maintain a persistent filter for each PEM that
connects to it. Persistent filters are stored local to
the PATROL Agent. The default persistent filter
allows the PATROL Agent to forward all event
types except information events to any connecting
PEM.

platform
Indicates which platforms the KM for Unix supports.

 polling
The process the computer goes through to check
any remote devices for operational status and
readiness to send or receive data.

poll time
The amount of time it takes for a parameter to be
discovered. Graphs and gauges appear only when
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a parameter receives its first data value from the
agent. If the poll time for a particular parameter is
10 minutes, then it will take up to 10 minutes for
that parameter’s icon to appear in the parameter
icon window.

Primary Node
HACMP Cluster Management KM specificity: this
information contains the name of the node that has
been elected by all available nodes running Patrol
Agent to represent information about cluster state
and display it directly in the Patrol Console main
window. 
This information is available in the cluster infobox.

PSL discovery
A type of application discovery in which the
discovery rules are defined using PATROL Script
Language (PSL). PSL discovery can consist of
prediscovery and discovery PSL scripts. The PSL
create function is used to create instances.

recovery action
An action defined as part of a parameter and
triggered when a parameter value returned falls
within a defined alarm range. A recovery action is a
command that executes to fix a possible problem
that would cause the alarm range value.

resource
Any computer or application that is running on a
machine that PATROL monitors.

Resource
Cluster entity, such as a disk, file system, netowrk
adapter, or application server, that is made highly
available in the cluster.

Resource Group
Set of resources handled as one unit. Configured
by user. See also cascading resources.

Rotating Resources
Resource groups that may be associated with one
or several nodes. Each resource group rotates
among all the nodes defined in the resource chain,
one resource per network per node. There must be
at least one standby node. The node with the
highest priority in the resource chain for the
resource group takes over for a failed node. When
a failed node joins a cluster, it does not re–aquire
its resources; it comes up as a standby.

scheduler
A PATROL Agent facility that is responsible for
executing all the parameters at their poll time or as
close to their poll time as possible.

self–polling parameter
A parameter command that has the ability to run
itself indefinitely. In PATROL, self–polling
parameters can be activated and given a

scheduling frequency by using the Schedule dialog
box. See parameter.

Service Adapter
The primary connection between the node and the
network. A node has one service adapter for each
physical adapter is used for AIX network
connections and is the address published by the
CLuster Information Program (Clinfo) to application
programs that wants to use cluster services.

session module
A knowledge module that contains the combined
information from every other Console previously
loaded during the Console session.

silent mode
A PATROL operating mode that prevents
information–type events from being stored in the
event repository. The silent mode is on by default
but can be changed for each computer instance.

simple discovery
A type of application discovery that uses simple
pattern matching for identifying the files and
processes associated with the application when
creating the rules for discovery.

SNMP
Simple Network Management Protocol. This
communications protocol is designed for network
management systems. The messages are typically
very short, perhaps just code numbers, that the
recipient is expected to translate into the desired
action.

SNMP Console
An interface to PATROL that collects parameters
and converts complex administration information
into numeric code, thus reducing routine network
traffic.

standard parameter
A PATROL parameter that contains instructions for
both gathering and displaying a value. Standard
parameter data–gathering can be scheduled. See
also parameter,  collector parameter, and
consumer parameter.

Standby Adapter
Backs up the service adapter. If the service adapter
fails, the Cluster Manager directs the traffic for that
node to the standby adapter. Using a standby
adapter eliminates a network adapter as a single
point–of–failure.

startup action
Commands that are executed by the PATROL
Agent against the computer while the PATROL
Agent is running and the Console is either
connected or reconnected. A startup action can
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initialize an application log file to prepare it for
monitoring, for example.

state
The condition of a monitored PATROL object.
States include normal, warning, and alarm. See
state change action.

state change
Any change–of–state that takes place on a
resource that PATROL is monitoring. 
Examples of state changes that can take place are
as follows:

• A parameter goes above or below its normal
range.

• The connection status of a computer changes
(goes void for example).

• A parameter description is changed for a class
of objects.

state change action
An action stored, maintained, and initiated by the
Console in response to a monitored object’s
change of state. The Console initiates state change
actions when notified by the PATROL Agent that a
monitored object has changed state. State change
actions can only be performed by OS commands
since PSL does not run on the Console. 
A common state change action is to change the
appearance of an object icon to represent the
real–time status of the object it represents.

static application
An application whose Knowledge Module (KM) is
loaded automatically by the PATROL Agent when it
starts. If a KM is loaded later, such as commanded
from the PATROL Console, it is dynamic, not static.
When the Console’s interest in an application
ceases, static application KMs remain loaded;
dynamic application KMs are unloaded. You can
also configure the Agent to consider specified
applications to be static, even if loaded
dynamically.

status
Indicates whether the parameter is active or
inactive on discovery.

Sticky Location
A special resource marker that resides in the
HACMP ODM and which indicates that:

• its associated resource group is sticky

• the node specified by its value fiels is the
associated home node. Sticky locations are
discarded when a cluster is rebooted (all nodes
go down at least once).

su command
su option user shell_args 

Allows you to become another user without logging
on and off the system, suspending your current
shell while logging you in as the substitute user.

super module
The combination of each subsequent knowledge
module that you load with previously loaded
knowledge modules to form one module. When
loading additional Knowledge Modules, you can
choose whether you want to overwrite identical
object definitions or keep the old definition.

suspend
An interruption of parameter data collection. All
parameters for a specific instance of an application
or a computer can be suspended. Suspending the
parameter does not affect how the parameter
activity level is defined (active or not active) for the
object class.

Synchronize Cluster Topology
Command that propagates the local node’s
definition of the cluster topology to the rest of the
cluster.

system knowledge module
The basic Knowledge Module for your operating
system (for example, Unix or Windows NT). It
needs to be loaded so that the PATROL can
identify the computer classes and display icons for
your managed computers.

task
A command or group of commands that can
execute on one object or several objects
simultaneously. A task runs in the background. A
task icon is displayed for each running task. You
can perform operations dynamically, such as stop,
start, and destroy, using the Task icon pop–up
menu.

UDP
User–datagram protocol 
A packet–level protocol used for application–to
application programs between TCP/IP host
systems. The valid port numbers used by PATROL
are four–digit integers greater than 1024.

unit
States in what form the output is expressed; for
example, percentage, number, or seconds.

user datagram protocol
A packet–level protocol used for application–to
application programs between TCP/IP host
systems. The valid port numbers used by PATROL
are four–digit integers greater than 1024.

user–defined command
A command defined by the user in the course of
this session. That is, it is not loaded from any
Knowledge Module.
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UUCP
Unix–to–Unix Copy Program

value set by
Identifies the collector or collectors that gather the
data for this parameter.

variable name
Refers to a language object.

view filter
A filter to screen events forwarded from PATROL
Agents to the PATROL Console so only those
events that match the selection criteria can be
viewed. After you create a view filter, it is
temporarily stored and can be re–applied to
selectively view only those events that match the
view filter criteria.

void state
A void state occurs when the network connection
between the Console and computer is down and/or
the PATROL Agent is not running.

warning
An indication that a parameter has returned a value
that falls within the warning range.

warning state
A warning state occurs when one or more
computer parameters are in a warning state and/or
an application whose state is propagated is in a
warning state.

worst parameter
The name of the parameter causing the most
problem.
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